Content Publisher Getting Started Guide
10g Release 3 (10.1.3.3.0)

March 2007
The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
Table of Contents

Chapter 1: Introducing Content Publisher
- Launching Site Builder ......................................................... 1-2
- Startup Screen ................................................................. 1-2
- Site Builder Main Window ................................................. 1-3
  - Menu Bar ................................................................. 1-3
  - Standard Toolbar ....................................................... 1-6
  - Large Toolbar .......................................................... 1-7
  - Popup Menus ............................................................. 1-7
  - Help ................................................................. 1-8

Chapter 2: How Site Builder Works
- A Simple Web Publication ................................................. 2-1
- More Options ............................................................... 2-2
- Working With Content Server ............................................. 2-3
- Project Setup ............................................................... 2-4
  - Ranks, Styles, and Patterns ........................................... 2-4
  - Templates and Elements ............................................... 2-5
  - The Project File ......................................................... 2-6
- Key Terms ................................................................. 2-7
- What's Next ............................................................... 2-13

Chapter 3: Scheduling Projects on Site Server
- Publishing in Site Server .................................................. 3-3
- Choosing Your Options .................................................... 3-3
- Versioning the Project File .............................................. 3-4
- Connecting to Site Server ................................................. 3-4
- Scheduling Projects for Translation .................................... 3-5
Table of Contents

Chapter 4: Project Setup in Content Server

Chapter 5: The Publishing Process
# Table of Contents

Adding a Linked Publication to a Project ........................................... 5-9
Updating Source Documents ............................................................. 5-10
Update Versions Command .............................................................. 5-11
Updating a Linked Publication ......................................................... 5-11
Updating Projects on Site Server ..................................................... 5-11
Specifying a Version of a Source Document ................................. 5-12
Staging a Project ................................................................. 5-14
Benefits of Staging ................................................................. 5-14
Setting Staging and Publishing Options ........................................... 5-14
Using the Stage Command ........................................................... 5-23
Fine-Tuning Property Values and Security Settings ....................... 5-24
Publishing a Project ................................................................. 5-27
Automating Staging and Publishing ............................................... 5-28

## Chapter 6: Setting Project and Application Options

Project Options ................................................................. 6-1
   General Settings ............................................................ 6-2
   File Naming Options ....................................................... 6-3
   Map File and Print Publication Options ................................ 6-4
   Repository Options ........................................................ 6-5
Application Options ............................................................. 6-6
   Logging Options ............................................................ 6-6
   General Options ............................................................ 6-7
   Dialog Options ............................................................... 6-8
   Site Server ................................................................. 6-9
   Viewer Options ............................................................. 6-9

## Appendix A: File Formats and Translation

File Formats ................................................................. A-1
Graphics Formats ............................................................... A-8
Translation Issues ............................................................. A-11
   OLE Object Support ........................................................ A-11
   HTML, XML, and PDF as Input Files ................................ A-12
   Graphics as Input Files .................................................. A-13
   Disk Space ................................................................. A-14
   Anti-Virus Software ........................................................ A-14
   Output HTML Pages ...................................................... A-15
About Styles in Excel and PowerPoint ........................................... A-15
   Styles in Microsoft Excel .................................................. A-15
# Table of Contents

## Appendix B: Templates and Graphics Sets
- Templates and Graphics Sets in Default.tcp ............................. B-2
- Default Settings for 14 General-purpose Templates .................... B-3
- Default Settings for 4 Specialized Templates .......................... B-4
- Template Guidelines ...................................................... B-5

## Appendix C: Third Party Licenses
- Apache Software License .................................................. C-1
- W3C® Software Notice and License ....................................... C-2
- Zlib License ...................................................................... C-4
- General BSD License ........................................................ C-5
- General MIT License ........................................................ C-5
- Unicode License .............................................................. C-6
- Miscellaneous Attributions .................................................. C-7
Introducing Content Publisher

Content Publisher comprises the workstation, Site Builder, and the server, Site Server. If you have not yet installed and configured Content Publisher, please see the Installation and Configuration Guide. (A PDF version is available in the Documentation folder of your installed directory, as well as on the Content Publisher CD-ROM.)

If you have already completed the “Seven Easy Lessons,” you are probably familiar with the key interface elements discussed here. In that case, you may want to just skim the contents of this chapter and move on to Chapter 2, which explains how Site Builder works.

In this chapter, you will:

- Learn how to launch Site Builder
- Become familiar with the Startup Screen
- Review the main window in Site Builder, including the menu bar, standard toolbar, and large toolbar
LAUNCHING SITE BUILDER

Once you’ve installed Site Builder, you can launch the Web publishing tool in a number of ways:

- Choose Programs from the Start menu in Microsoft Windows, select the Content Publisher program group, and click Stellent Site Builder.
- Choose the Run command from the Start menu and type the full path and name of the executable file, in quotes, in the text box (for example, "C:\Program Files\Stellent Content Publisher\Transit.exe").
- Double-click the executable file Transit.exe in Windows Explorer.
- Double-click the shortcut icon on the desktop (if you have set one up).

However you choose to launch it, Site Builder opens initially with an About Box, which appears briefly on top of the Site Builder main window before being replaced by the Startup Screen.

STARTUP SCREEN

The Startup Screen (see Figure 1-1) provides alternative ways to start a new project and open an existing one. It also offers three learning opportunities:

- Wizard—Opens the Add a Document wizard, which walks you through the basic steps required to turn a source document into a Web page.
- Seven Easy Lessons—Opens a series of lessons (in PDF) that provide a quick introduction to the basics of using Site Builder.
- Tutorial—Opens a second, more advanced series of lessons (also in PDF) that build on what you have learned in “Seven Easy Lessons.” (You don’t have to complete “Seven Easy Lessons” before tackling the Tutorial, but we recommend that you do.)

Once you select an option in the Startup Screen, you won’t return to this screen during your current session in Site Builder. Rather, you’ll complete project setup in the main window, using the commands available there.

You can click Cancel to bypass the Startup Screen, if you prefer, and open a new or existing project directly from the File menu. You can also click Don’t show this screen again if you don’t want the screen to be available for future sessions. (To return to the screen at any time, choose Show Startup Screen from the Help menu.)
Introducing Content Publisher

Figure 1-1  The Startup Screen

This startup screen can be opened from the Help menu at any time.

SITE BUILDER MAIN WINDOW

The tools you use to set up publications for translation reside on the menu bar, the standard toolbar, and the large toolbar of the main window (see Figure 1-2). The menu bar contains all of the commands in Site Builder, and the standard toolbar contains most of them. The large toolbar, which offers only key commands, may be especially useful when you start using the application, since you can quickly identify each button. Let’s review all the commands.

Menu Bar

To open a menu, click the menu name. You can then click any command from the drop-down list of commands. You can also use keyboard shortcuts to open menus and activate their commands.

- The File menu provides commands to open new and existing project files, to save project files, to open the Folder Import wizard, to import and export publications, and to exit Site Builder. The last four projects you have worked on are listed at the bottom of the menu.
Figure 1-2  Content Publisher main window

The Publication Hierarchy pane displays the root publication and any subpublications, while the Contents pane shows details of the publication selected in the Publication Hierarchy pane.

- From the **View menu**, you can view the translation log file and open any source document selected in the Contents pane in its native format. (In the case of a source document from Content Server, you open the Content Information for the source document. You can open the native file from there.) You can also register the project with Content Server (for the purpose of previewing a source document in HTML) and open the Application Options and Project Options dialog boxes. The latter contain a variety of options for such settings as logging level and the output page naming convention you want to use. (They are discussed in detail in Chapter 6.) Finally, you can open the Toolbars submenu, which lets you show or hide the status bar and both toolbars, as well as customize the standard toolbar.

- From the **Add menu**, you can add a document, a reference page, a publication, or a Directory Item. When you add a Directory Item from the file system, individual source documents of a specified format automatically become a part of the translation process when they are added to the selected directory. When you add a Directory Item from Content Server, or from an FTP or HTTP site, you must use the Update Versions command before translating. However, if you are using Site Server, it doesn’t matter where the Directory Item is from—the server will automatically update the Directory Item before translating and publishing the project. (See Chapter 4 for more on Directory Items.)

- From the **Publication menu**, you can open the Layout dialog box, where you can create a frameset or table layout for your publication. You can also add associated files (which become an integral part of your project and are processed by Site Builder.
during translation); and open the Publication Properties dialog box. All three commands are also available from the popup menu that appears when you right-click a publication in the Publication Hierarchy pane. (Table layout is discussed in the Help system. See the Table layout book on the Contents page.)

- The **Template menu** provides access to the four template editing options: **Element Setup, Formatting, Navigation, and Globals**. You can also open the Choose Template, Edit Template, and Manage Templates dialog boxes.

- From the **Run menu**, you can translate source documents. The Translate command runs an incremental translation. Typically, this is what you will want to do most of the time as you create and fine-tune your Web publications. (The command is also on the standard and large toolbars). The Translate All command runs a complete translation (which you can also accomplish by deleting all your output files or changing your output directories). With the Translate Selected command, you can translate a selected portion of your publication. (First select one or more files in the Contents pane before choosing the command, which is also available by right-clicking the selected files to open a popup menu. Choosing the command opens the Selective Incremental Translation dialog box.)

The Run menu also contains five commands that come into play when you use Site Builder with Content Server: Update Versions, Stage, Staging Options, Publish, and Publishing Options. Update Versions is an important command for updating your source documents before translation (it can also be used to update source documents from an FTP or HTTP site). The Stage command is used to “stage” your final output to a content server, so that you can review and approve your Web publication before publishing live to your Web site, using the Publish command. (See Chapter 5, “The Publishing Process,” for more information on staging and publishing.)

- The **Viewers menu** enables you to launch the default Web browser associated with Site Builder and to associate additional viewers with the program. The viewers can include utilities such as Notepad as well as browsers.

- The **Server menu** lets you move project files to a network location (by using the Project Export wizard) and schedule the automated translation of projects (by using Site Scheduler to connect to Site Server).

- The **Help menu** provides access to the comprehensive online Help system, to the “Seven Easy Lessons” and the Tutorial, and to product and copyright information.

Once you have opened an existing project or created a new one, and completed setup, you will spend most of your time using the four template editing commands available from the Template menu and standard toolbar. These commands are also available from the Edit
Template dialog box. Project setup issues specific to using Site Builder with Content Server are discussed in Chapter 4, “Project Setup with Content Server.”

**Standard Toolbar**

Buttons on the standard toolbar mirror most of the commands available from the menu bar. The standard toolbar can be seen as a set of smaller toolbars, set off from each other by separators. As you pass your cursor over the toolbar, a tooltip will explain each command.

**Figure 1-3** Standard toolbar

You can use drag-and-drop to position the toolbar anywhere on the desktop. You can also resize the toolbar with your mouse (see Figure 1-4). To remove any command from the toolbar, select the icon, hold down the Alt key, and drag the icon off the toolbar. To customize the toolbar, click Toolbars on the View menu and choose Custom from the submenu.

**Figure 1-4** Standard toolbar, shown here as a toolbox

The vertical separators ensure that related icons stay together when the toolbar is resized.
Large Toolbar

The large toolbar down the right side of the main window (see Figure ) is similar to the standard toolbar below the menu bar, but it contains only the main commands you are likely to use in Site Builder. Since the buttons are labeled, new users may find this toolbar useful at first. (To hide the toolbar, choose Large Toolbar from the Toolbars submenu of the View menu.)

![Large Toolbar](image)

Figure 1-5  Large toolbar

The large toolbar, which you can hide or show at any time by choosing Large Toolbar from the Toolbars submenu of the View menu. You can also drag and drop the toolbar on the desktop.

Popup Menus

Throughout Site Builder there are many opportunities to right-click in order to open a popup menu with a selection of commands appropriate to where you are in the interface. For example, when you right-click a source document in the Contents pane of the main window, the following popup menu is displayed.
Figure 1-6  Popup menu

<table>
<thead>
<tr>
<th>Add</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td></td>
</tr>
<tr>
<td>Open Source Document</td>
<td></td>
</tr>
<tr>
<td>Translate Selected</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
</tr>
<tr>
<td>Update Versions</td>
<td></td>
</tr>
<tr>
<td>Publication</td>
<td></td>
</tr>
<tr>
<td>Properties...</td>
<td></td>
</tr>
</tbody>
</table>

Popup menus can be opened from different parts of the interface. The commands available will vary, depending on where you are in the interface and what you right-click.

There are many “right-click opportunities” in Site Builder to help you speed up the execution of commands.

Help

Also available throughout Site Builder are numerous Help buttons, which can be found on most of the property sheets and dialog boxes:

Clicking a Help button opens a topic in the Help system that is specific to the property sheet or dialog box you happen to be working in. Remember, too, that you can always choose Help Topics from the Help menu to gain access to all of the topics in the Help system.
If you have completed the “Seven Easy Lessons,” you already know how easy it is to create a simple Web publication in Site Builder, one consisting of a single source document that becomes a single Web page. Before you tackle more sophisticated publications—consisting of a fully linked set of Web pages created from multiple source documents—you should become familiar with the key concepts outlined in this chapter.

A SIMPLE WEB PUBLICATION

The figure below shows Web publishing with Site Builder in its simplest terms. You can see how a source document created in a word processor, which traditionally might be printed from a laser printer or by other conventional means, can easily be imported into Site Builder and re-purposed for viewing on a Web server.

To accomplish this in Site Builder, you would

- start a new project
- create a new publication
- select a source document from your file system (or content server)
- associate a template with that document
- import styles or patterns from the document, or ask Site Builder to apply ranks
- format the elements associated with those styles, patterns, or ranks
- translate the document to turn it into a Web page

All of this can be done with surprising ease in Site Builder.
Traditional print documents can easily be repurposed for publishing on an intranet.

**More Options**

Thanks to the power of Site Builder, you can just as easily handle more complex projects. For example, to create a more sophisticated Web publication, you could

- include numerous source documents in a variety of file formats in your project
- obtain these source documents just as easily from a repository such as a content server, or an FTP or HTTP site
- build a reference page, such as a table of contents, key word index, or Query page, to aid navigation and information retrieval
- associate different templates with different types of source documents and reference pages to create a special look for each topic area
- build a publication hierarchy by adding publications to the root publication and then adding source documents and reference pages to each publication
- add a Directory Item to a publication, to let content authors drop documents in a specified format into that directory and to have those documents automatically translated to become a part of your Web publication
- create a frameset to help structure your Web publication and treat special content in consistent ways
- turn a regular project into a master project by including a linked publication as a subpublication in the master project’s publication hierarchy

Some of this greater sophistication is depicted in the figure below.

**Figure 2-2  More sophisticated Web publishing with Content Publisher**

With different templates you can fine-tune the look and behavior of source documents in your project and publish to a Web server, whether for an intranet, extranet, or Internet site.

**Working With Content Server**

When Site Builder is used with Content Server, even more options are available to you. You can

- take advantage of Content Publisher’s dual-publishing capability to first stage your output for review and approval before you publish it to your Web site
- create a staging workflow for your staged output so that individual Web pages can be formally reviewed and passed back, if necessary, to content authors and the project author for changes
- register your project with the staging server to facilitate such a workflow setup
- register the project (separately) to facilitate previews of Web pages by content authors as they create source documents and check them into Content Server
- create a special Query reference page for your Web publication that lets users search your complete Web site for information
Place document information from the Content Information page of your source documents in the output Web pages you create.

**PROJECT SETUP**

However simple or complex your Web publication, there are certain key stages in the process of creating that publication. Much of what you do in Site Builder during the preliminary stage of project setup is related to creating one or more templates to capture a variety of formatting and other instructions that determine the look and behavior of your Web publication onscreen. All that information is saved (with other information) in a project file that can be opened at any time so that you can quickly re-create your publication or edit the templates.

Project setup is discussed more fully in Chapter 4, “Project Setup in Content Server,” especially in the context of taking source documents from a content server. For now, let’s review what happens each time you add a source document to a project in Site Builder (whether from the file system or a content server). The content of those documents is, after all, what concerns you the most.

**Ranks, Styles, and Patterns**

When you select a source document—that is, add it to your project—the first thing you must do is associate a template with that document. (As soon as you add the document, Site Builder automatically opens the Choose Template dialog box. It is not critical which template you initially associate with the source document, because you can return to this dialog box at any time and choose another template instead.)

When you select a template, you must also decide which setting you want to use under Import Styles or Patterns. With the default setting None, Site Builder creates a default set of ranks that are applied to content at translation time to ensure that top-level hierarchy is always treated consistently, even when the source documents are inconsistently formatted. Site Builder creates a element for each rank and places those elements in the template. If you select Styles or Patterns instead, Site Builder proceeds to import styles or patterns from the source document and automatically generates a element for each style or pattern and places those elements in the template, instead.

Thereafter, all editing begins by first selecting the template in the Contents pane of the main window and choosing one of the template editing options. In most cases, you then select one or more elements to apply precise settings to specific portions of the document’s content.
During translation, Site Builder takes the content of each source document, reformats it per your instructions in the template and elements, and produces an HTML file, which it places in an output directory. This file is the Web page you view in a Web browser. Your source documents remain unchanged. And you can update each Web page of your Web publication repeatedly with push-button simplicity whenever you revise the appropriate source document.

So one of the keys to Site Builder is understanding the power and flexibility of templates and elements. Once you’ve gone through the initial phase of setting up a project, you’re ready to tap this power and flexibility to create the exact look and feel that you want for your Web pages.

**Templates and Elements**

A template in Site Builder is similar to a template in a word processor. It contains formatting instructions that determine how your source document will look when turned into a Web page and viewed in a Web browser.

In Site Builder, you can always “pass through” a source document and its formatting, based on its existing styles. In other words, you can translate the document without changing the elements. You may, in fact, want to do this each time you create a new publication and translate its source documents for the first time. (To do so, simply associate the source documents with the Blank template in the Choose Template dialog box.) However, the power of Site Builder resides in your ability to not only reformat the original attributes of any style (font, size, etc.), but to use templates and elements to shape the hierarchy of a document and to make its content accessible to users in different ways.

You can use elements to place content in different reference pages or suppress it entirely from a Web page; create button and text bars for navigation; create links between different portions of a source document; embed HTML or scripting code in portions of the content; and much more. In short, elements allow you to treat individual portions of the content in special ways.

As a result, you could have two templates that contain a duplicate set of elements that mirror the styles of a particular document. If you format the two templates differently, you can switch templates at any time to produce a dramatically different result in the Web page you create when you translate the document. All this information is captured in a template, which, in turn, is captured in the project file unique to each publication.
The Project File

When you create a project, you’ll likely want to preserve all the important details of the project so that you can update it at any time. Site Builder simplifies the management of Web publications by allowing you to capture important information about each project in its own project file.

Each time you begin a new project, you open a copy of the default project file, Default.tcp. “Unsaved” appears in the title bar. (You can choose Save As from the File menu to name the file and save it to whatever directory you want.)

With the project file, you capture information about

- the publication hierarchy, consisting of the root publication and all subpublications at levels below the root publication
- each publication in the hierarchy in terms of its source documents, output pages, optional reference pages, the template associated with each document, and also the frameset (if any) that is associated with the publication
- special subpublications that consist of Directory Items or linked publications
- output directories
- any global instructions that apply to the Web publication as a whole

If you use the same setup for source documents and output directories each time, updating an archived Web publication is easy. You simply revise the content of a source document, open the project file for the publication that contains that document, and retranslate. (If you choose Site Builder’s incremental translation option, Site Builder detects which source documents have changed since the last translation and translates only those. You will want to choose the Update Versions command first.)

Note: The default name for a new project, “Unnamed,” appears at the top of the Publication Hierarchy pane and also above the Contents pane. You can use the same name for both the root publication and the project file, if you want. To name the root publication, right-click the publication and choose Properties from the popup menu, and enter a new name in the Publication Name text box.
KEY TERMS

Below is a list of key terms used in Site Builder. These terms are essential to your understanding of Site Builder if you are to use the Web publishing tool to full advantage.

- **project**—The overall term for the Web publication you create that encompasses the project file, its templates, and all source documents, related graphics, and associated files.

- **project file**—What you need to begin a new project. Site Builder starts with a copy of the default project file already open (“Unsaved” appears in the title bar). You use a project file to save important details about a project, including the publication hierarchy, the location of source documents, the template associated with each document, and the location of output directories for the HTML files produced during translation. (Content Publisher automatically zips your project file each time you save it in order to compress it. The .tcp extension remains unchanged.)

- **Default.tcp**—The default project file that is installed in the ..\Resource\en folder of the Content Publisher directory. Site Builder opens a copy of Default.tcp each time you start a new project. You can edit Default.tcp, if you want, to customize the templates or settings you want available each time you start a new project.

- **DefaultWML.tcp**—The default project file used to create WML projects. Also available in the ..\Resource\en folder in the Content Publisher directory. (Copies of both default project files are on the CD-ROM.)

- **master project**—The same as a regular project except that it contains one or more linked publications; that is, one or more subpublications in the project’s publication hierarchy contain a link to another project file.

- **linked publication**—A publication with its own project file that is linked to an existing project, which becomes the master project, as a result. You must open the linked publication by itself in Site Builder in order to edit it. Once the linked publication is edited, you can update it within the master project by using the Update Versions command.

- **project author**—The individual responsible for a project, that is, for creating the project and templates, setting staging and publish options, and so forth.

- **content author**—The individual responsible for creating the source documents that reside in a repository (typically, Content Server) and are the proposed content of your Web site.
Webmaster—The individual responsible for reviewing a project on the staging server and for authorizing its final approval and release to the Web site (publishing server).

source document—The content you want to translate into HTML format and display in a Web browser. Site Builder can convert source documents in all the major word processing formats and in certain spreadsheet and presentation formats (see Appendix A, “File Formats and Translation”). Once you translate each source document, it becomes a Web page for viewing in a Web browser.

generation—a container for the source documents that you want to translate and any reference pages you want Site Builder to build.

Each new project has a root publication. (Its default name, “Unnamed,” appears at the top of the Publication Hierarchy pane. To name the root publication, right-click it and choose Properties from the popup menu.) You can create a publication hierarchy by adding publications to the root publication, publications to those publications, and so on. (Each publication, when added to another, becomes a subpublication.) Whatever the publication—the root publication itself or one of its subpublications—it should be a logical entity that reflects a natural grouping of content, to which you can add frames, tables, reference pages, etc., to reinforce that content.

publication hierarchy—What’s visible in the Publication Hierarchy pane, that is, the root publication and all subpublications at all levels. Each project in Site Builder consists of at least a root publication. But you can add publications to the root publication, and publications to those publications. When you select a publication in the Publication Hierarchy pane, its contents display in the Contents pane. You can view the contents of only a single publication at a time in the Contents pane.

Web publication—What you create in Site Builder for viewing in a Web browser. At its simplest level, a Web publication consists of a single Web page (from the translation of a single source document). But a Web publication typically will comprise many Web pages, including reference pages such as a table of contents (TOC). Moreover, the publication hierarchy can be quite sophisticated, consisting of many publications at different levels, each one containing its own source documents and reference pages, with some of its subpublications representing a Directory Item or a linked publication.

Web page—The smallest unit of a Web publication, which may reside in a single frame of a frameset. Site Builder creates two kinds: body page and reference page.

body page—What you create each time you translate a source document. Body pages correspond to the content of source documents and are the main output of translation. Each one is an HTML file. (If your source document contains embedded or linked
graphics, Site Builder converts them into individual graphics files, in the GIF, JPEG, or PNG format. So a body page may have related graphics files.)

- **reference page**—An optional page built during translation. Reference pages (except for Query pages) derive their content from body pages and are automatically linked to them. There are five types: publication Table of Contents (TOC), List of Tables (LOT), List of Figures (LOF), Index, and Query. Each one is an HTML file. (Note: The TOC you place at the beginning of body page is a “page TOC” and is a part of the same HTML file as the body page. Its contents typically differ from the contents of the publication TOC.)

- **Directory Item**—A directory or folder that you have added to a project in Site Builder so that source documents placed in the directory at any time become part of the project.

On the file system or an FTP site, you can also create a *dynamic* Directory Item, whereby Site Builder incorporates into a project not only the identified folder (directory), but all the folders below that folder in the system hierarchy. When the directory is in Content Server, the contents of the directory are defined by search criteria.

Whether the Directory Item is based on the file system hierarchy, an FTP or HTTP site, or a query in Content Server, you must use the Update Versions command before you translate. However, updating is automatic when you schedule projects for translation by Site Server, because the server automatically updates Directory Items before it translates projects.

- **repository**—A place where electronic files are stored. Usually implies that access to the files in the repository, and the use of those files, is controlled (as in the case of a content management system). May also be known as a “library” or “folder.” In Site Builder, the file system, an FTP site, an HTTP site, and Content Server are all referred to as “repositories.”

- **content server**—In the context of the publishing process within Content Publisher, a content server may be a *source* server (where source documents reside), a *staging* server (where the project is staged to for review purposes), or a *publishing* server (the Web site).

- **stage / staging server**—Part of the dual-publishing option in Content Publisher. To stage a project is to copy the translated output from the file system to a content server known as the staging server so that the contents of your Web publication can be formally reviewed and approved before being published. If you set up workflow on the staging server (and register the project on that server), you can use workflow to facilitate the review process.
How Site Builder Works

- **publish / publishing server**—Part of the dual-publishing option in Content Publisher. To publish a project is to copy the translated output from the file system to a content server known as the publishing server—in effect, your Web site. Typically, you will want to “stage” your project before you publish it (go live on your Web site). But you can publish without staging (and stage without publishing).

- **Web site**—Where you publish your Web publication. Referred to also as the “publishing server.”

- **staging workflow**—The process that facilitates the formal review of Web pages on a staging server before a project is finally approved and published. If workflow has been set up on the staging server and the project has been registered on that server, workflow begins automatically as soon as the project is staged.

- **problem report**—A report written to highlight a problem with the content or some other aspect of a Web page that is part of your staged output. The report is written in the problem report section of a special version of the Content Information page, which is created when you register a project on the staging server. Problem reports can be used in conjunction with staging workflow to review your staged output.

- **registration**—The process of registering a project with a content server. There are two types of registration. Registering a project on a source server facilitates a “preview” of a source document when the document is checked into the source server (that is, a rendition of the source document in HTML format to see what the document will look like when formally translated). Registering a project on a staging server enables staging workflow (and the formal review of the entire Web output), once a project is staged. It also allows you to create problem reports on staged output.

- **frameset layout**—One of two layout options in Site Builder (the other is HTML table layout). With frameset layout, you create a set of frames that help you organize content for viewing in a Web browser. In Site Builder, all body pages must display in a single frame of any frameset you use. But other frames can contain graphics, TOCs, and other types of reference pages. They can also be used to target URLs, HTML code, or JavaScript. You can use the same frameset for all the publications in the publication hierarchy of a given project or a different frameset for each one.

- **HTML table layout**—One of two layout options in Site Builder (the other is frameset layout). With HTML table layout, you can create a structure of cells instead of frames to organize your content for viewing in a Web browser. All body pages must display in a single cell of any HTML table that you create. But other cells can contain graphics, TOCs, and other types of reference pages. They can also be used to target URLs, HTML code, or JavaScript. You can use the same table layout for all the...
publications in the publication hierarchy of a given project or a different table layout for each one

- **template**—A key feature in Site Builder, similar to a word processing template, that allows you to capture all the formatting instructions associated with a document. Most of these instructions are associated with the individual elements that the template contains (some are associated with the template itself).

You can associate only one template with a given document, but the same template can be associated with many different documents. Templates are saved as part of the project file and typically don’t exist as separate files. But you can create a template file, if necessary, to export a template for use in another publication. You can also place a template file on a network and establish a link to that template from any Site Builder workstation connected to the network. Multiple users can link to the template at the same time. (You must import a linked template into Site Builder in order to edit it.)

A template associated with a source document is sometimes referred to as a *body page template*, to differentiate it from the special *reference page template* you associate with a reference page.

- **element**—Another key feature of Site Builder (often referred to simply as “element”). When you import styles or patterns from a source document, Site Builder generates an element for each style or pattern. (If your document contains a style named Heading 1, Site Builder creates an element named Heading 1.) Likewise, if you choose ranks, Site Builder will create an element for each rank (which will be applied at translation time). Once Site Builder creates an element for each style, pattern, or rank, you can use these elements to format your source documents.

Elements reside in a template. Their names are displayed in an Elements list found in many of the tab dialogs. Each element represents corresponding content in the source documents. As you format the element, you’re setting formatting instructions for all content that corresponds to that element. You can select multiple elements and format them as a group.

- **style**—There are two kinds of styles in Site Builder: paragraph and character. A *paragraph style* is a set of formatting characteristics that are saved and given a name so that the style can be applied to any paragraph in a source document. Typical styles in a word processing file are Normal, Heading 1, and Footer. Site Builder imports named styles from a source document and generates an element for each style. You format content by formatting the elements to turn the document into a Web page. You use mostly paragraph styles to create Web pages.
A *character style* is where selected subject matter within a paragraph has been assigned formatting attributes different from the paragraph style. The formatting of a character style overrules the subject matter formatting of the paragraph style. Word processor programs often contain built-in character styles such as Annotation Reference and Footnote Reference.

- **pattern**—In many instances, organizations have manually formatted documents. Site Builder can handle such documents by recognizing patterns in how the font attributes have been set. Say your source document is set totally in the Normal style, with two major headings set in 16-pt bold and 12-pt italic, respectively. And let’s assume that no other text uses these font attributes. In that event, Site Builder will recognize the font attributes of these headings as patterns and assign pattern names to them (and probably create the elements Heading 1 and Heading 2 for the headings and assign the Default Paragraph element to all other content). Once Site Builder assigns elements to those patterns, you can edit the elements to format your document. (Site Builder can also handle text documents, which are completely unstyled, but your formatting options here are obviously limited.)

Like styles, you can have paragraph patterns and character patterns. Character patterns can be useful for isolating specific text or data within a paragraph that you want to treat in a special way. Many templates in the default project file contain three standard character patterns that can be particularly useful: HTTP, WWW, and Email.

- **rank**—Serves as a way to recognize the *content hierarchy* of a document. Can be especially useful when you’re importing a variety of source documents where some contain named styles and others have manually formatted content, or where styles have been inconsistently applied. Rather than import styles or patterns, Site Builder creates a default set of ranks, which it applies to content at translation time to ensure that the top-level hierarchy of the documents is treated consistently. Ranks can be especially useful where you are translating legacy documents or have added a Directory Item to your project.

**Note:** In the Choose Template dialog box, the default setting under Import Styles or Patterns is None. This means that Site Builder will use a default set of ranks rather than import styles or patterns. You must formally select Styles or Patterns in order to import styles or patterns.

- **metadata**—Information associated with a source document, such as the author’s name, the document’s title, and the document’s date of creation. Site Builder recognizes three kinds: content server (which you assign to a document when you check it into Content Server), and standard and custom (which are created in the application used to create the source document). Unlike styles, patterns, and ranks,
metadata are not automatically associated with elements. But you can make any metadata element-based and then place that element in your Web pages and publish the element to a content server.

**WHAT’S NEXT**

Now that you understand some of the key concepts and terms used in Site Builder, you are ready for the next chapter, where you will explore project setup when using Site Builder with Content Server.

To learn more about the publishing process, including the dual-publishing model, the notions of staging and publishing, and the registration process, see Chapter 5.

Chapter 6 addresses project and application options.
SCHEDULING PROJECTS ON SITE SERVER

When you create projects in Site Builder, you have the option of translating those projects manually in Site Builder or using Site Server to automate the translation process and gain greater control over your Web publishing efforts. With the utility Site Scheduler, you can schedule projects to run on the server at any time, as long as you have access to the workstation or content server on which the project file and all source and associated files reside.

Site Scheduler is installed with Site Builder and can be opened from the workstation at any time. If you install Site Server on a dedicated server machine, Site Scheduler is also installed. In that event, you can open the Scheduler from the Windows program group or by double-clicking TCScheduler.exe in the installed directory.

The figure below shows how Site Scheduler allows Site Builder to communicate with Site Server. As you schedule each project, that project becomes part of a task list in Site Scheduler. The log file shown is the one generated for server activity, not from translating projects on the task list. (See Chapter 6, “Setting Project and Application Options.”)
The various components of Content Publisher. Source documents and associated files may be stored in Content Server. That same content server, or additional content servers, may be used for staged and published output.

The project files you schedule—as well as all of your source documents and associated files—can just as easily be stored in Content Server as the file system. In that event, Site Server will need access to the content server that stores these files, as well as access to any additional content servers you use for staged and published output. (For more information on staging and publishing, see Chapter 5, “The Publishing Process.” (For more information on configuring Site Server to gain access to Content Server in order to translate scheduled projects, see Chapter 1 of the “Installation & Configuration Guide.” A PDF version can be found in the Documentation folder of your Content Publisher directory, as well as on the Content Publisher CD-ROM.)
PUBLISHING IN SITE SERVER

There’s one significant difference between publishing in Site Builder (when used as a standalone workstation) and publishing in Site Server. In Site Builder, four important commands are executed manually and separately, whereas in Site Server these same commands can be executed automatically, as one: Update Versions, Translate, Stage, and Publish.

That is, when you schedule a project for translation by Site Server, Site Server can automatically:

- update all source documents at run-time (unless you have specified that certain versions be used),
- translate the documents,
- copy the translated documents to the staging server (as specified in Staging Options), and also
- copy the translated output to the publishing server (as specified in Publishing Options)

Choosing Your Options

You don’t, in fact, select Update Versions in Site Scheduler: when you choose the Translate command, the project is automatically updated when it runs at the scheduled time in Site Server. (Since updating makes no sense unless you also translate, updating does not occur if you simply stage or publish your project.)

You are unlikely to use the Stage and Publish commands together, since the point of staging is to review your Web output before publishing (placing it directly on your Web site). Typically, you would schedule your project just to Translate or to Translate and Stage. You would then schedule the same project as a separate task just to Publish.

For example, you might set up a task for the project to be updated, translated, and staged on the 4th, 11th, 18th, and 25th of each month, and also set up a separate task for the same project to be published on only the 1st of each month. Thus, after the first day of each month, you would know that you had a month to review and approve successive staged versions of your project on your staging server. (Of course, you can only stage and publish if you have set staging and publishing options, respectively.)

On the other hand, if you have full confidence in your Web output, you may choose to bypass staging altogether, in which case you would use the Translate–Publish sequence.
(For more information on staging and publishing, see Chapter 5, “The Publishing Process.”)

Finally, you can also choose to simply update and translate. This might make sense if, say, the Webmaster wants to wait until all content authors have submitted their projects for the Web site and all tasks have been processed cleanly by the server. It might also make sense if, say, you’re still in the process of creating your project and it just doesn’t make sense to stage (or publish) just yet.

**Versioning the Project File**

In Site Builder, you create a project file when you save a new file to Content Server for the first time. Thereafter, each time you use the Save command, you create a new version of the project file currently in Content Server.

In Site Server, the project file is automatically updated just before translation. (If, for example, the project contains one or more Directory Items, it is very likely that new source documents have been added to the project since it was scheduled for translation.) Site Server then translates the source documents and saves the project file in Content Server. (It may also stage or publish the translated output, if one of those options has been selected when the project is added to the task list.)

When Site Server saves the project file to Content Server, it can either overwrite the existing version of the file or create a new version. You set the appropriate option in Site Scheduler when you schedule the project for translation. (Once you select the project file for scheduling, a dialog box opens to ask whether you want to version or overwrite the file.)

For versioning in Site Server, see the section “Versioning the project file” in Chapter 4; also, “Scheduling projects for translation,” below.

**CONNECTING TO SITE SERVER**

1. With Site Builder running, click **Scheduler** on the toolbar or choose **Stellent Site Scheduler** from the Server menu.

2. In the Site Scheduler window, click **Connect** on the toolbar or choose **Connect** from the Server menu, to open the Connect to Server dialog box.

   Note: If you have previously connected to a particular server, you will automatically connect to that server when you start Site Scheduler. (The title bar will display the
name of the server you are connected to.) If you now want to connect to a different server, use the Connect command.

3. In the text box, type in the name of the server you want to connect to, that is, the machine on which Site Server is running.

   If you are running Site Server on your local machine and are not sure of the server’s name, right-click Network Neighborhood in Windows Explorer and choose Properties from the popup menu. On the Identification tab dialog you will see the name of your machine displayed in the Computer Name text box.

   If you are running Site Server remotely, click Browse in the Connect to Server dialog box to open the Browse for Computer dialog box, which displays the Network Neighborhood. You should see the name of the machine there. Select the machine from the list. (If it’s not available, contact your network administrator.)

   Note: If you are running Site Server remotely, Site Server must be running in order to successfully connect to it.

4. Click OK. The title bar of Site Scheduler displays the name of the machine you are now connected to.

   Once you are connected to the machine on which Site Server is running, you are ready to schedule projects for translation.

---

**Scheduling Projects for Translation**

Scheduling a project in Site Scheduler is a two-part exercise: first you specify the task, and then you set the actual schedule. If you are both staging and publishing the project, you will likely want to schedule the project twice (using the first task to stage the project, and the second task to publish it).

**Specifying the Task**

To specify the task:

1. In Site Scheduler, click **New Task** ( ) on the toolbar or choose **New** from the Task menu to open the New Task dialog box.
Scheduling Projects on Site Server

**Figure 3-2** New Task dialog (Specification tab)

The Specification tab dialog of the New Task dialog box in Site Scheduler.

2. In the Specification tab dialog, select **Stellent Content Server** from the Repository drop-down list, and click **Browse** opposite the Project field to open the Select a Project dialog box.

3. Conduct a search for project files and then click the appropriate **Select** button for the one you want to schedule.

4. The Select a Project dialog box closes and the Content Publisher dialog box opens.

**Figure 3-3** Content Publisher dialog

As you schedule each project for translation, you must decide whether to overwrite or version the project file in Content Server.

5. Click **Yes** to create a new revision of the project file in Content Server or **No** to overwrite the current version in the content server.
The Content Server dialog box closes, and you are returned to the New Task dialog box.

6. In the Log File text box, choose a directory and name for a log file that you would like to have a report of your translation written to.

This information is from the perspective of the server machine. So if you choose a directory such as C:\My Documents, your log file will be written to the server’s local drive, in the directory My Documents. Choose a drive and directory that is accessible by both the server and your login. You may want to consult your network administrator for this information.

Use UNC paths rather than DOS paths, as these are more universal and users won’t have to worry about whether or not they are using the same drive mappings as the server.

Example: ..\News\Share might be the UNC equivalent of drive S:\.

To ensure that you use an UNC path, always use the Browse button opposite the Project text box to select the project file, and always start your search from Network Neighborhood in the Open dialog box (you can use the Look In drop-down box to locate Network Neighborhood). Starting your search from Network Neighborhood will ensure that a UNC path is returned in the Project text box in the New Task dialog box.

7. Set a logging level. (For more on logging, see the notes at the end of this section and also in Chapter 6, “Setting Project and Application Options.” The online Help system also explains the options available here.)

8. Under Format, accept the default HTML (to create a log file in HTML format for viewing in your browser) or select Text instead.

9. Under Steps, select the appropriate check boxes for the steps you want Site Server to complete when the project is run.

If you select Translate, the project will be automatically updated first. You can select all three check boxes, but you will lose the advantage of staging if you do so. To both stage and publish your project, you will want to schedule two tasks. In the first task, you would schedule the project for the sequence Translate–Stage (and thus select the Translate and Stage check boxes). For the second task, you would want to select only the Publish check box.

If you haven’t staged your project and want only to publish, you would select the Translate and Publish check boxes. Conceivably, you might want to check only Translate.
10. Under Notification, complete the required information if you want Site Server to automatically generate an email notification each time the task runs. See “Sending an Email Notification for a Task,” below, for more information.

11. In the Post-processing field, enter the name of the executable file that will trigger any post-processing activity, immediately the project has run. (You need enter only the file name if the executable resides in the root of the installed directory for Site Server; otherwise, enter a full path.)

**Scheduling the Task**

To schedule the task:

1. Click the **Schedule** tab to open that tab dialog.

   **Figure 3-4** New Task dialog (Schedule tab)

   ![New Task dialog (Schedule tab)]

   This is where you schedule the project.

2. Schedule a time for your project to run.

   Note that the scheduling times are set up in increments of a minute. If you select Every, the default setting of 1:00 represents one hour. With this option you should also specify the time period during which the task should be run.

3. Click **OK** to return to Site Scheduler, where the new task is now listed in the task list.
4. Repeat the above steps for the Specification tab dialog, and also these for the Schedule tab dialog, to schedule other projects for translation. When your task list is complete, click the Close box on the title bar or choose Exit from the File menu.

If you prefer, you can quickly test a scheduled task to see that it will run smoothly without warnings and errors at the scheduled time. (See “Testing a scheduled task,” below.)

Please note the following:

- The log file you create in the New Task dialog box (on the Specification tab dialog) is the “translation log” for the scheduled project. It is the same log file you would get if you ran a translation at your workstation, using Site Builder. You must set the path and file name under Logging, because any logging information set in the Application Options dialog box in Site Builder is user-specific for a given machine and is not saved to the project file. If a log file is not specified here, none will be created.

- In addition to the “translation log” specified in Site Scheduler, you can also have a “server log,” which is geared toward the server administrator and which you specify in Site Server. See Chapter 6, “Setting Project and Application Options.”

- When you use Site Scheduler to schedule a project for translation by Site Server, you cannot have that project open in Site Builder during translation; otherwise, a sharing violation will occur.

- If your project file is on the file system, Site Server will automatically overwrite the current version of the file after it completes the translation.

**SENDING AN E-MAIL NOTIFICATION FOR A TASK**

Each time a scheduled task runs on Site Server, an email can be automatically generated to confirm how successfully the task has been translated, staged, or published. You can also attach the translation log file to provide additional information on how the task ran.

Email can be sent to anyone within the organization, but you will likely want the Webmaster to be alerted on the outcome of translation, staging, and publishing.

**Configuring Site Server to Send E-Mail Notification**

To configure Site Server to send email notifications:

1. From the Windows Control Panel, double-click the Stellent Site Server icon to open the Site Server dialog box.
2. Click **Notifications** to open that tab dialog. Figure  shows the default settings, which you may have accepted during installation.

3. Under Mail Server Configuration, enter the address of your mail server in the **Mail Server** text box, such as **mail.company.com**.

4. Under **SMTP Port**, accept the default of 25 or, if necessary, enter a different port number.

5. In the **Notification sender email address** text box, enter the email address that represents the message sender. This may be a general mailbox, such as **info@company.com**. The email address entered here will be listed as the sender each time Site Server generates a notification email message.

![Figure 3-5 Configuring Site Server to send e-mail notification](image)

The Notifications tab dialog of the Site Server dialog box, where you configure email notification for tasks.

6. In the **System administrator email address** text box, enter the email address of the system administrator if you want Site Server to send an email notification message to this address every time certain server errors occur. This may be a general mailbox, such as **sysadmin@company.com**, or any valid email address in the organization. This address is optional. If you provide it, the addressee will be notified by email of any server errors that occur when the task runs.
7. Click **OK**.

Please note the following:

- An email notification on server errors contains information similar to that found in the server log.
- Even if you don’t want Site Server to generate email notification on server errors, you must enter information in the Mail Server Configuration and Notification Sender Email Address text boxes, since this information determines the mail server and sender address that Site Server uses when sending all email notifications.
- To send an email notification for a particular task, you must set options for that task in the New Task or Edit Task dialog box of Site Server, as described in the following section.

**Setting Up an E-Mail Notification for a Task**

To set up an e-mail notification for a task:

1. In the Site Scheduler main window, click **New** on the Task menu to open the New Task dialog box, or select an existing task and click **Edit** on the Task menu to open the New Task or Edit Task dialog box.

![Figure 3-6 New/Edit Task dialog (Specification tab)](image)

This is where you set up e-mail notification for a task.
2. Under Notification, in the **Email Address** text box, enter the email address of the person who will be notified of the publication status, such as `webmaster@company.com`. You can enter only one address in this field.

3. Under Notification, from the **Notification Level** drop-down list, select the level of notification you want to use for the task being scheduled.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - No notification</td>
<td>No email is generated.</td>
</tr>
<tr>
<td>1 - Notify on errors</td>
<td>Notification of errors that occur during translation, staging and publishing.</td>
</tr>
</tbody>
</table>
| 2 - Success with output | ¡ Notification of errors that occur when output is generated during translation, staging and publishing, **and**  
                              ¡ Notification when output is generated and translation, staging and publishing succeed.  
                              When you select this level you will receive an email only when output is generated as a result of a task being run. |
| 3 - Always             | Notification of all errors and successes that occur during translation, staging, and publishing. |

The information contained in the email is a summary of the translation log file. The following example displays the body of an email notification message for a task where the level was set to 3 – Always:
4. If you want to attach a log file, select **Attach Log File to Notification**. (You must also specify a log file and set the logging level under Logging.)

5. Click **OK**.

Please note the following:

- To send an email notification for a task, you must also set mail server, port, and sender information in the Site Server dialog box, as explained above, in “To configure Site Server to send email notifications.”

- You can include the same project in more than one task (but only one project in each task). For example, you may want to set up email notification for a task that directs Site Server to translate and stage a project when it is run, and set notification for a different task that is set to publish the project at a later date.

## Testing a Scheduled Task

You may want to test a task before its scheduled time to run to be sure that there will be no problems when the task runs later, at the scheduled time. You can do this at any time before the scheduled time, including when you first add the project to the task list. (However, you cannot test a task on the task list that has expired.)

1. In the Site Scheduler window, select the task you want to test.

2. Click **Run** on the toolbar or choose **Run** from the Task menu (or right-click the task and choose **Run Task** from the popup menu).
The Last Run column indicates progress as the task runs. It displays a green check mark to denote that the task has run successfully or a red cross to denote that the task has not run successfully. In either case, the time of the test also appears in the column.

**Figure 3-7  Site Scheduler**

On this task list, the Last Run column reveals that tasks 1 and 2 failed to run successfully the last time and that task 3 has run successfully.

A task might fail to run for different reasons. For example, the project file may no longer exist or the machine on which Site Server is running does not have access to the content server in which the project file resides.

You can easily obtain preliminary information on any task that has run (or failed to run).

3. Right-click the task in the task list and choose **Info** from the popup window. The Task Info dialog box opens.
This project has run successfully without warnings or errors.

The Task Info dialog box provides a preliminary account of how the task has run. You should always check the log file in the event that a task fails to run successfully, or has run successfully but with warnings or errors.

**MANAGING THE TASK LIST**

Projects can be added to the task list by users at workstations throughout the organization. Unless the Webmaster is set up as a superuser, however, he won’t be able to view all of the tasks on the list.

To accomplish this, the Webmaster must create a new DWORD value for the following Key in the Registry:

-HKEY_CURRENT_USER\Software\Stellent\Content Publisher\Scheduler\6.0\Settings

The Value Name of the DWORD is “superuser” and its Value Data is 1.

You can manage the task list in Site Scheduler very easily. As superuser, your privileges include the ability to edit tasks but not to change their ownership. A simple task list (with all the project files in the file system) is shown in Figure 3-9.
Site Scheduler shows the task list with two projects each scheduled twice (once for staging, once for publishing).

The window displays key information about tasks on the task list, as follows:

- **ID**—The project ID is assigned by Site Server. It is used simply to distinguish between the tasks that are run.
- **Project**—The path and name of the project file that has been added to the task list.
- **Status**—The status of the task at any time. A task can be in one of five states:
  - Waiting: The task is awaiting its appointed time to run.
  - Pending: The task is ready to run, once other projects are completed.
  - Running: The task is currently running.
  - Expired: The task has run the required number of times and is not scheduled to run again.
  - Locked: The task schedule is currently being edited by another user.
- **Last Run**—The date and time the task last ran. A green check mark denotes that the task has run successfully, while a red cross denotes that it has not.
- **Next Run**—The date and time the task is scheduled to run next.
- **Owner**—The login name of the user who scheduled the task.

---

**Pause Publishing Command**

You can use the Pause Publishing command to temporarily halt all translations scheduled to run on Site Server. Once you pause publishing, Site Server will continue to accept the scheduling of projects, but it won’t translate any tasks until you choose the Continue command. You may want to use the Pause Publishing feature when your server is...
experiencing significant activity and other tasks take priority over your Web publishing efforts.

Pause publishing works a little differently, depending on whether Site Server is installed as an OLE Automation server or as a Service.

**Site Server Running as an OLE Automation Server**

**Pausing Publishing**

To pause publishing when running Site Server as an OLE Automation server:

1. Right-click the Stellent Site Server icon ( ) on the Windows taskbar to display the Site Server popup menu.

2. Click Pause Publishing. The popup menu closes. Site Server will pause all scheduled translations until you decide to continue.

**Resuming Publishing**

To continue publishing after having paused:

1. Right-click the Stellent Site Server icon ( ) on the taskbar in Windows to display the Site Server popup menu. Since you are in a pause state, the Pause Publishing command is now grayed out and the Continue command is now available.

2. Click Continue.

**Site Server Running as a Service**

**Pausing Publishing**

To pause publishing when running Site Server as a service:
When Site Server is set up to run as a Service on a machine running Windows, the Site Server icon is not available from the taskbar. In that event, you can activate the Pause Publishing command in the following way.

1. Click **Settings** on the Windows Start menu, and choose **Control Panel** from the submenu.
2. In the Explorer window that opens, double-click the **Stellent Site Server** icon, to open the Site Server Properties dialog box.
3. Click **Control** to open that tab dialog (see Figure Note:).
4. Click **Pause Publishing** to pause the publishing process.
5. Click **OK**.

**Resuming Publishing**

When you are ready to continue publishing, return to this tab dialog and click Continue.

![Figure 3-10  Resuming publishing with Site Studio running as a service](image)

**Note:** The Control tab dialog in the Site Server Properties dialog box is available only when you run Site Server as a Service.
Suspending An Individual Task

Finally, on occasion you may decide to temporarily suspend the translation of a particular project, one that is scheduled for translation at a regular time each day.

1. Select the project in Site Scheduler, and choose **Edit** from the Task menu to open the Edit Task dialog box.

2. Click **Schedule** to open that tab dialog, and under Keep Running Until, click the **Down** control for the list box in order to change the Expires On date to yesterday’s date.

3. Click **OK** to return to the Site Scheduler main window. The Status column opposite the project will shortly read Expired.

Thus, without changing any of the settings for running this project, you have temporarily stopped the project from being translated. You can reschedule it at any time by re-entering the Edit Task dialog box and changing the Expires On date to an appropriate time in the future.
Chapter 4

PROJECT SETUP IN CONTENT SERVER

Chapter 1 offered a brief introduction to the Site Builder interface. If you have worked through the “Seven Easy Lessons” and the Tutorial, completing some or all of those exercises, you should have become familiar with other aspects of the interface.

Thus far you have been working in the file system. In this chapter, you will review project setup primarily in the context of Content Server. With Content Server, you are more likely to be taking source documents from the content server and using the content server for both staged and published output. You can also use the content server to store the project files you create. The figure below depicts the more sophisticated environment you are working in.
You can add source files from Content Server to a project, publish back to Content Server, and save project files to the content server.

Project setup is the process of starting a project, creating a publication hierarchy, and populating the root publication and subpublications with documents, reference pages, and Directory Items. In the process, you will want to review the ranks, styles, or patterns you are using in your templates. You may also want to consider creating framesets and even designating directories for your staged and published output.

Some of these tasks—as well as those you undertake after project setup to fine-tune the look and behavior of your Web pages—are the same whether you are working in the file system or the content server.

In this chapter we will review those tasks that are an essential part of project setup. We will also touch briefly on some tasks that may not be critical to project setup (depending on the nature and complexity of your project) and which are dealt with in detail elsewhere.

This section has these topics:

- Creating a Project File in Content Server (page 4-3)
- Versioning the Project File (page 4-6)
- Opening a Project File From Content Server (page 4-9)
- Creating a Publication Hierarchy (page 4-10)
- Creating a Frameset (page 4-10)
Creating a Project File in Content Server

The main difference between creating a project file in the file system and creating one in Content Server is that when you save a project file to the content server, you can take advantage of the security, versioning, and other features of the content management system.

You may want to create a test project in Site Builder, to be used throughout this chapter. To create a project file in Content Server, perform these tasks:

1. With a new project started in Site Builder, click Save As on the File menu. The Select a Repository dialog box opens.

   ![Select a Repository](image)

   Figure 4-2 Selecting a repository

2. Select Stellent Content Server from the drop-down list and click OK.
3. If you are entering Content Server for the first time during your current session in Site Builder, the Enter Network Password dialog box may appear so that you can log on. Complete the required information to gain access to the repository, and then click OK.

4. The Project Check In dialog box is displayed. Under Type, select the document type you want to associate with the project file. You may want to create a special Type for project files to facilitate future searches for project files.

**Figure 4-3** Project Check In dialog

This is where you create a project file in Content Server for a new project. Note that the Content ID begins with “StellentProject_”.

5. In the Title text box, enter a descriptive title for the project.

This entry will create the name of the project file. Do not provide the.tcp extension that Site Builder uses for project files. Content Server will add it automatically. The extension won’t be visible in Content Server, but you will see it in the title bar of Site Builder.

6. Complete the other fields, as necessary. For example, you may want to create a special security group for project files. See your Content Server documentation for more information.

7. Click the **Assign Info** button to save the information and return to the main window in Site Builder, where the project file name now displays in the title bar (with the.tcp extension). You can continue project setup.
8. If you have multiple content servers installed, you will need to identify which server you want to obtain source documents from. If all the servers have been properly registered on your machine, the Choose a Content Server dialog box will open as soon as you complete Step 2, above:

**Figure 4-4** Choosing a content server

![Choose a Stellent Content Server dialog box](image)

9. Select the content server you want to use from the drop-down list and click OK.

This dialog box also will display when you open a project file, add a Directory Item, and set staging or publishing options. The content servers available from the drop-down list are those that have been registered on your machine. If all the servers you want to access were not registered during the installation of Content Publisher, see Chapter 1, “Configuring Content Publisher,” of the “Installation & Configuration Guide,” for more information.

**The History File**

When you create a project file, Site Builder automatically creates a companion history file. So when you save the new project file “Project,” you actually create Project.tcp (the project file) and Project.tch (the history file).

Site Builder uses the history file to track the date and time-stamp of each source document so that when you run an incremental translation, it can identify those documents that have been updated since the last translation and translate only those. The history file also tracks which elements have been promoted and which have been included in reference pages.
(To avoid the history file becoming too large, you should promote only those elements that you plan to use in a project.)

The history file is an important file, but one you never need to worry about. Should you delete the file, Site Builder will simply run a full translation the next time you translate your publication, even if you choose an incremental one, and create a new history file at that time.

When you check a project file into Content Server for the first time, you are actually checking in both the project file and its companion history file. You won't be aware of checking in the latter and you won't see it in Content Server. (In fact, the history file isn't created until you close the project the first time. It is then updated each time you close the project in subsequent sessions.) When you check out the project file in Site Builder, the history file is automatically checked out, too. As with source documents, you are always working with temporary versions of both the project file and the history file.

To reduce their file size, both project and history files are automatically zipped by Content Publisher. (Though zipped, they retain their .tcp and .tch extensions.)

**VERSIONING THE PROJECT FILE**

With an existing project open in Site Builder, you create a new version of the project file each time you save your project. When you schedule a project for translation on Site Server, you can choose to overwrite the existing version of the project file in the content server instead of creating a new version.

**Creating a New Version of Project Files in Site Builder**

To create a new version of a project file in Site Builder, perform these tasks:

1. With an existing project open in Site Builder, click **Save** on toolbar or choose **Save** from the File menu. The Project Check In (New Revision) dialog box opens.
The Project Check In (New Revision) dialog box opens each time you choose the Save command in Site Builder for an existing project. Any information you want to associate with the new version can be entered in the Comments box.

2. In the Comments box, type any information you want to associate with the new version you are creating. (You can change any of the editable values.)

3. Click the Assign Info button to save your comments with the new version of the project file. The Project Check In (New Revision) dialog box closes.

If you want to create a new project file based on an existing project file, use the Save As command instead. The Project Check In dialog box will appear, showing document information for the existing project, except that the Title field will be empty. You can give the project file a new name and change any of the properties of the original project file.

**Note:** If you leave all the original fields as they are, be sure to enter a different title for the new project file. Otherwise, you will create a second project file with the exactly the same document information and only the version history of the two project files will be different.

**Creating a New Version of Project Files in Site Server**

To create a new version of a project file in Site Server, perform these tasks:

When you schedule projects for translation by Site Server, you can choose to overwrite the version of the project file in Content Server or create a new version each time the project runs.
1. Click **Scheduler** on the standard toolbar in Site Builder or choose **Stellent Site Scheduler** from the Server menu to open Site Scheduler.

2. Click **New** on the toolbar to open the New Task dialog box. (If you have not previously connected to Site Server, click **Connect** on the Server menu. For more information, see Chapter 3.)

3. Select **Stellent Content Server** from the Repository drop-down list, and then click **Browse** opposite the Project text box. (If you have multiple content servers registered on your machine, choose the appropriate content server from the drop-down list in the Choose a Content Server dialog box.)

4. In the Select a Project dialog box, conduct a search for project files and then click the appropriate **Select** button for the one you want to schedule.

   If you have set up a special document type for project files, you will be able to refine your search by selecting this type from the Type drop-down list. Instead, you could enter `tcp` in the Native File Extension field to generate a list of all project files in the content server.

5. The Select a Project dialog box closes and the Content Publisher dialog box opens.

6. Click **Yes** to create a new revision of the project file in Content Server or **No** to overwrite the latest version in the content server.

   If you click **Yes**, a new version of the project file will be created each time Site Server runs the project.

   As soon as you select a project file from Content Server for scheduling in Site Server, this dialog box will open so that you can choose to version the project file or overwrite the file that is in Content Server.

7. Complete the other information in the New Task dialog box, as appropriate.

   **Note:** If you schedule a project to run repeatedly in Site Server, you may later want to change from overwriting the project file to creating a new version (or vice versa). In that event, you will have to delete the original project from the task list and schedule the project anew, this time choosing the alternative option. For more on scheduling projects for translation by Site Server, see Chapter 3.
OPENING A PROJECT FILE FROM CONTENT SERVER

Once you check a new project file into Content Server, you can open the file at any time from Content Server for future sessions in Site Builder.

To open a project file from Content Server, perform these tasks:

1. Click Open ( ) on the toolbar to open the Select a Project dialog box.
   
   If the Select a Repository dialog box opens first, select Stellent Content Server from the Repository drop-down list and click OK. (If necessary, then select a content server in the Choose a Content Server dialog box.)

2. Create a search in order to locate the project file you want to open. You can speed up your search by selecting the appropriate document type from the Type drop-down list (assuming your system administrator has set up a special document type for project files). Alternatively, enter tcp in the Native File Extension field to facilitate your search.

3. Click the Select button for the project file to open.

Figure 4-6  Selecting a project

The Select a Project dialog box in Content Server shows the results of a search. As soon you click the Select button for a project, you will return to Site Builder with that project open and its title displayed in the title bar.
CREATING A PUBLICATION HIERARCHY

You have seen how to create, version, and open a project file in Content Server. With a new project started, you can continue project setup in the main window by developing the basic structure of your publication.

In the Publication Hierarchy pane, you create a structure consisting of the root publication plus any other publications you want to add to the root publication to help organize the source documents you want to translate. You can create publications just as you do folders in Windows Explorer.

A publication is simply a container for source documents, reference pages, Directory Items, linked projects, and possibly other publications, which you add to each publication in the hierarchy by first selecting the appropriate publication. (Whichever publication is selected is the active publication, and its contents are visible in the Contents pane.)

The publication hierarchy that you create and the source documents and reference pages that you add to each publication not only determine the content of your Web publication, but also influence the navigation sequences necessary to explore that content.

See Lesson 14 in the Tutorial for more information on the publication hierarchy.

CREATING A FRAMESET

As you create the publication hierarchy, you should also be thinking of how you might use framesets to dramatically improve the onscreen presentation of your Web publications. With a frameset layout you can not only organize content by assigning it to different frames, but also improve the navigation options available to users.

Even a publication consisting of only a table of contents and a few body pages can benefit from a simple frameset of two frames. If you have a complex publication hierarchy and reference pages at different levels, a frameset of multiple frames can be an invaluable tool for creating an intuitive Web site where users can easily find what they are looking for.

For the purposes of a simple walk-through of project setup, framesets aren’t discussed in this chapter. See Lessons 1 and 12 in the Tutorial (in PDF format).

An alternative to frameset layout is HTML table layout. You can structure the content of your Web publication with a table and cells just as you would a frameset and frames (there are differences between the two layout approaches, however). For more on tables, open the Help system and then open “HTML table layout” from the Contents tab.
Once you have saved a new project file to Content Server, created a publication hierarchy and possibly also one or more framesets, you are ready to add source documents, reference pages, Directory Items, and linked publications to the project.

Since reference pages are generated when Site Builder translates the project, we won’t discuss them here. (For more information, see Lesson 6 in the “Seven Easy Lessons.”) Instead, we’ll review the two ways you can obtain source documents from the content server. We’ll also review additional options when adding source documents from the file system.

However, before you add even a single document to your project, you should decide whether you want to use the default htm extension for your translated output. If you want Site Builder to apply another extension, instead, now is the time to make that change. For more information, see Chapter 6, “Setting project and application options.” (You can set a special extension just for the source documents of a Directory Item. You do this as you add the Directory Item to your project, in the Options tab dialog of the Directory Item dialog box.) See, also, “Setting staging options,” in Chapter 5, for information on the default hcsp extension that is used when staged or published output is checked into a content server.

To add a source document from Content Server, perform these tasks:

1. On the Add menu, click Document.

2. In the Select a Repository dialog box, once again select Stellent Content Server from the drop-down list as the source for the documents you want to add to your publication.

Figure 4-7 Selecting a repository

![Select a Repository dialog box](image)

3. If this is to be the sole source of those documents, you can also check Don’t show this dialog box again. (If you later need to show this dialog box, open the Applications
Options dialog box from the View menu, switch to the Dialogs tab dialog, and select the appropriate check box.)

4. Click **OK** to close the Select a Repository dialog box. (If the Choose a Content Server dialog box opens, select a content server from the drop-down list and click **OK**.) The Select a Document dialog box is displayed.

**Figure 4-8** Searching for documents

![Select a Document dialog box](image)

The Select a Document dialog box enables you to conduct a document search to select documents from Content Server to add to your publication in Site Builder.

5. Conduct a search for the documents you want to add to your project. (For more about searching, consult your Content Server documentation.)

6. Once the search results display in the dialog box, click the **Add All to Project** button to add all the documents listed from the search, or select those documents you want to add and click the **Add Selected to Project** button. The Select a Document dialog box will close and the Choose Template dialog box will open.
Here you can select which documents you want to add to your project.

7. In the Choose Template dialog box in Site Builder, associate a template with the source documents you have just added to your project.

   If you add multiple source documents at once, only the first source document listed in the Choose Template dialog box is highlighted when you enter the dialog box. However, the template you choose is associated with all the source documents.

8. Click **OK** to return to the main window in Site Builder. The documents are now listed in the Contents pane, with their associated template displayed in the Template column. The title of each source document is used to name the output HTML file (with the .htm extension added).

Please note the following:

- Although you must associate a single template with multiple source documents when you first add them to a project, you can later associate a different template with those documents or even a different template with each one. (Select any document in the Contents pane and re-open the Choose Template dialog box.)

- The default setting in the Choose Template dialog box is None, which means that Site Builder applies a set of default “ranks” to content rather than imports styles or patterns from the source documents. For more information, see “Choosing a template,” later in this chapter; “Ranks, styles, and patterns,” in Chapter 2; and Lesson 10 of the Tutorial.
As you set up and maintain projects, remember that you can right-click the name of a publication, document, or reference page at any time to open a popup menu that includes the Properties command. By choosing this command, you can view and edit the properties of the publication, document, or reference page in the Properties dialog box that opens. In the case of a source document, you can also choose the Open Source Document command to open the source document in its native format, assuming the application used to create the document is available on your machine. (When the source document resides in Content Server, the command opens the Content Information page in Content Server for the document, where one of your options is Get Native File.)

When you add documents that reside in Content Server, you do not check out those documents as you would in your normal use of Content Server. Rather, Site Builder identifies the current version of each document when it is added to the publication and obtains a working copy of that version from Content Server at translation. As a result, someone else may check out one or more of those documents during your session in Site Builder, between the time you start your project and are ready to publish. That’s why you may want to use the Update Versions command before your final translation. (See the section “Updating source documents” in Chapter 5 for more information.)

**ADDING A DIRECTORY ITEM FROM CONTENT SERVER**

As you saw, you can use the Add Document command to add either single source documents to a project or multiple documents at a time. A more efficient way of adding multiple documents is to create a Directory Item.

In the file system, you identify a folder you want to turn into a Directory Item. As a result, whatever source documents are later added to that folder become part of the project. This is particularly advantageous when you automate the translation process by scheduling projects to run on Site Server. In that event, you can add new source documents to the Directory Item at any time with the assurance that they will be included in the next scheduled translation. (In Site Builder, you must be sure to use Update Versions in order to include new source documents in the next translation.)

In Content Server, the Directory Item feature works a little differently—you use a search to define the Directory Item. That is, you create a query. Any source documents that meet the search criteria are considered a part of the Directory Item and are therefore included in the next translation. Moreover, any documents subsequently added to the content server
that meet the search criteria are automatically included in future translations—if you use the Update Versions command before you translate.

When you automate the translation process by scheduling projects on Site Server, all Directory Items are automatically updated. That’s because Site Server can automatically execute four commands that are executed manually and separately when you use Site Builder as a standalone workstation: Update Versions, Translate, Stage, and Publish. (For more information, see the section “Publishing in Site Server” in Chapter 3.)

To create a Directory Item in Content Server, perform these tasks:

1. On the Add menu, click **Directory Item** to open the New Directory Item Properties dialog box. If the Select a Repository dialog box opens first, select **Stellent Content Server** from the drop-down list and click **OK**.

   **Figure 4-10**  New Directory Item Properties dialog box

   ![New Directory Item Properties dialog box](image)

   This is where you create a Directory Item for your project in Site Builder.
2. Click the **Browse** button opposite Directory to open the Directory Item Properties dialog box.

3. If the appropriate content server is not displayed under Content Server, click the **Stellent Content Server** button to open the Choose a Content Server dialog box. Select the appropriate content server from the drop-down list and click **OK**.

   **Figure 4-11**  Directory Item Properties dialog box

   ![Directory Item Properties dialog box](image)

   This is where you select a content server and specify the Directory Item (query) you want to add to your project.

4. Under Directory Item Information, enter a name for query in the Name field. This name will identify the query itself and will be appended to the content server name in the Contents pane. It will thus help you differentiate between Directory Items where a publication contains more than one Directory Item.

5. Click the **Query** button to open the Specify a Search dialog box.
Figure 4-12  Specifying a search

The Specify a Search dialog box, where you set search parameters to create a Directory Item in Content Server.

6. Set your search parameters. (Consult your Content Server documentation if you need more information.) Then click the Search button.

7. Next, you’ll see a preview of the current hits resulting from the query. Review this list to be sure that your Directory Item will capture all the documents you want to capture—and no additional ones. If you need to refine your query, click the Back button and set new parameters for another search.

8. If the list of documents is satisfactory, click the Add Query to Project button to return to the Directory Item Properties dialog box, where the name of the content server and the query can be seen in the Directory field.
Figure 4-13  New directory item properties

The completed New Directory Item Properties dialog box. Output directories will be created using “Marketing” as the name of the folder within the publication hierarchy of the project.

9. In the Title text box (Figure 9), enter the title you want to use for the search. (You don’t have to enter one. If you do, it can be used to populate the titles of your output pages.)

10. In the Map file property text box, you can enter text to specify a custom item that will be added to the output Map file (MapFile.xml). This could enable you, for example, to place security information in the Map file.

11. In the Prefix to be added to all output filenames text box, enter the prefix to apply to each output file in this Directory Item. (This is not required.)
12. Under Output Directories, enter names for the output directories you want to use for these source documents.

You can leave these text boxes blank, if you prefer. If you enter paths, these must be for the file system, because when you translate source documents (with the Translate or Translate All command), you can send the output files only to the file system. This is explained in the next section.

Generally, you won’t want to enter a full path. By default, Site Builder uses the full path specified for the root publication and mirrors the publication hierarchy in the structure of the output directories it creates. So in the fields for output directories for a Directory Item, you can simply enter just the names for the output directories you want to use (as shown in Figure 9). This will be especially helpful where a publication contains more than one Directory Item, and you want to segregate the output files of the different Directory Items.

13. Under Template, click the **Choose Template** button to open the Choose Template dialog box and select the template you want to associate with the source documents in the Directory Item.

With a Directory Item, all source documents must be associated with the same template.

Please note the following:

- On the Sort tab dialog of the Directory Item Properties dialog box, you can influence the order in which source files are translated and linked. On the Options tab dialog, you can set conversion options and an extension for output files that will apply only to the Directory Item.

- Once you have created a query, you can edit it at any time. Click the **Information** button at the upper right of the General tab dialog (Figure 6) to open the Details dialog box. Then click **Modify** to return to the Directory Item Properties dialog box. There, you can click **Query** if you want to change the metadata for the query.

- See Lesson 15 in the Tutorial for more information.

**ADDING A DYNAMIC DIRECTORY ITEM FROM THE FILE SYSTEM**

When you add a Directory Item from the file system, you have the potentially powerful option of making the Directory Item **dynamic**. You do this by selecting the **Include subdirectories** option in the Options tab dialog of the New Directory Item Properties...
dialog box. (This option is available only when you’re adding a Directory Item from the file system or an FTP site.)

If you accept the default setting (by leaving the check box cleared), only individual source documents at the top level of the specified folder will be added to the project. That is, you’ll create a Directory Item in the usual way. However, if you select **Include subdirectories**, Site Builder not only imports the specified folder, but also the hierarchy of folders that the specified folder contains. Moreover, it automatically processes source documents in *all* the folders.

Please note the following:

- Only the parent Directory Item is visible in the Contents pane.
- Site Builder in effect creates a hidden subpublication for the subfolders of the parent Directory Item. The subpublication inherits the properties of the publication in which the dynamic Directory Item resides.
- If you create a TOC for the parent Directory Item, you are, in effect, creating a TOC for each subfolder—and the contents of the subfolders are promoted so that the TOC for the parent Directory Item summarizes the complete hierarchy of the dynamic Directory Item.
- Promotion and linking specified in the template for the TOC of the parent Directory Item apply to all subfolders. Likewise, any reference pages you assign to the parent Directory Item (as well as any files associated with the parent) are automatically inherited by the subfolders, too.
- Site Builder includes in translation any new subfolders added to the hierarchy in the future. This can be handled automatically (see “Updating source documents,” in Chapter 5).

**USING THE FOLDER IMPORT WIZARD**

Yet another way to add multiple source documents to a project is by using the Folder Import wizard. The Folder Import wizard works only with the file system. You can use the wizard to add a whole hierarchy of folders from the file system (similar to, but not quite the same as, the dynamic Directory Item). You can either treat each of those folders as a Directory Item or simply import all the documents in those folders at the time you run the wizard.

With your test project still open in Content Server, you can run the Folder Import wizard as follows.
To run the Folder Import wizard, perform these tasks:

1. In the Publication Hierarchy, select the publication that is to contain the imported folder.

2. Select **Import** from the File menu to start the Folder Import wizard.

3. Browse to the folder in your file system, select that folder, and click **OK**.

4. In the next wizard screen (see Figure ), select the import method you want to use.

5. Then click **Next** and follow the instructions in the screens that follow.

**Figure 4-14** Folder Import wizard

The Folder Import wizard screen on which you decide whether to import the folders and their documents as is, or to treat each folder as a Directory Item.

You can choose to import the documents in the folders at that time or treat the folders as Directory Items. If you choose the former, Site Builder will treat the folders as new subpublications and add them—with their contents—to the publication originally selected in the Publication Hierarchy pane (step 1, above).

If you choose to treat the folders as Directory Items, each folder will be added to your project as a Directory Item. However, this isn’t quite the same as creating a dynamic Directory Item from the same folder selected in step 3, above.

The dynamic Directory Item versus the Folder Import wizard
When adding source documents from the file system, it’s worthwhile comparing the dynamic Directory Item to the Folder Import wizard. Like the dynamic Directory Item, the Folder Import wizard can import a portion of a hierarchy from the file system. However, there are important differences:

- Whereas the dynamic Directory Item is *dynamic*, the Folder Import wizard is *static*. That is, Site Builder recognizes any new folders added later to the hierarchy of a dynamic Directory Item, but it ignores any new folders added later to the hierarchy imported by means of the Folder Import wizard.

- Only the parent Directory Item of a dynamic Directory displays in the Contents pane, but the individual Directory Items imported by means of the Folder Import wizard can be seen in the Contents pane, depending on which subpublication (folder in the hierarchy) is selected in the Publication Hierarchy pane.

- Since you can see only the parent Directory Item of a dynamic Directory Item, the same template and settings must be applied to all folders and documents in a dynamic Directory Item. Since you can see the individual Directory Items that result from importing a folder hierarchy with the Folder Import wizard, you can apply different templates and settings to each Directory Item in the hierarchy.

The dynamic Directory Item option is turned off by default. However, you can turn on this option at any time.

**CHOOSING A TEMPLATE**

Site Builder makes it easy to complete project setup quickly and translate documents with the assurance that you’ll create good-looking Web pages, whatever your content.

Your initial choice of templates isn’t critical, because you can quickly switch the template associated with a document or reference page at any time. Moreover, the main differences between the templates in the default project file are the choice of a graphics Set and whether the CSS option (for cascading style sheets) is turned on or off. But you can change both options easily.

Still, you will want to settle on your templates during project setup, because as you begin to fine-tune your publication, you will quickly begin to capture important information that is saved to the project file. Since most of this fine-tuning is based on either the template itself or the element the template contains, it’s important to create the right set of elements during project setup.

Ideally, when you choose the template, you will want to decide whether to accept the default setting None. With this setting, Site Builder won’t import styles or patterns from
the source documents. Rather, it will create a set of default ranks that will be applied to the 
content of the source documents at translation to ensure that the top-level content of the 
source documents is always treated consistently. The default setting avoids problems that 
can arise where you have a large number of source documents with a mixture of named 
styles and manually formatted styles and the documents are all associated with the same 
template.

Whichever approach you take, Site Builder creates an element for each rank, style, or 
pattern, and places the elements in the template that you associate with the source 
document. You use those elements to format your Web pages. The goal, remember, is to 
create a set of elements that allow you to manipulate key portions of content in terms of 
formatting, navigation, promotion, and the like. This may mean creating new ranks, styles, 
or patterns in Element Setup once the initial importation of documents is complete.

**Figure 4-15  Element setup**

In Element Setup property sheet you can check all the elements in your template, based on 
the ranks, patterns, or styles in the template.

Part of your “template strategy,” especially if you create a complex publication hierarchy, 
is deciding what content you want to promote to which reference pages. You may find it 
advantageous, for example, to create multiple TOC pages that differ only in how 
promotion is handled. (In that event, you would probably want to fine-tune a single TOC 
in terms of formatting, etc., before creating copies of this template for other portions of the 
publication hierarchy.)
Once you are done in Element Setup, the initial phase of project setup is complete. The Contents pane displays the name of the output page you would create if you translated the source document. It also lists the name of the template associated with the document. If you have added any reference pages to the publication, these, too, are listed in the Contents pane.

If you want your output HTML pages to carry the .html extension instead of the .htm extension, you should change this now, during project setup (see “Setting project and application options,” below). Also, depending on your approach to project setup, you may need to start thinking about locations for your translated, staged, and published output.

For more information, see “Ranks, styles, and patterns,” in Chapter 2; also, Lesson 9 of the Tutorial. Whenever you change this setting, the new setting will prevail until you change it again.

**DESIGNATE AN OUTPUT DIRECTORY**

Once you have set up your project in Site Builder, you will initially follow the two-step sequence of Translate–View as you fine-tune your template and other settings to create your Web publication. In fact, you will probably use this sequence repeatedly until you are satisfied with your publication structure, the formatting of source documents, and the content and formatting of reference pages.

With the Translate, Translate All, and Translate Selected commands your output files will be saved only to the file system. This is convenient, because as you experiment with template settings, and the like, you’re probably not ready to place any output files on the staging server, which only the Stage command can do.

To set an output directory, perform these tasks:

1. Right-click the root publication in the Publication Hierarchy pane and choose **Properties** from the popup menu to open the Publication Properties dialog box.

   A full path is required only for the root publication. For subpublications and Directory Items, you can provide just the name of the output directory you want to use. In this way, all output files generated from source documents and for reference pages will be placed in a hierarchy of output directories that mirrors the publication hierarchy. One advantage of this is that if you ever want to move your translated output to another location, you only have to change the entries in the Properties dialog box for the root publication.
The Publication Properties dialog box, where you can specify a directory on your file system for translated output. Output pages and graphics can be placed in separate directories, if you want. Note the use of a full path and special directory for Gallery Graphics.

2. Under Output Directories, in the Pages text box enter the path for the output directory you want to use for output HTML files created from your source documents. Click the Browse button, if necessary, to locate the directory you want to use.

3. In the Graphics text box, enter the path for the directory you want to use for output graphics files. You can use a different output directory for graphics, if you prefer.
4. Click **Use gallery graphics directory** if you want to place copies of the navigation and other graphics from the Gallery in a single output directory. Then provide a full path for this directory.

This check box is available only in the Publication Properties dialog box for the root publication. By creating this special directory, you avoid creating duplicate Gallery graphics, which can be especially desirable in the case of large, multi-level Web publications.

5. Click **OK** to return to the main window.

When you are ready to stage and publish your project, you must set up Staging Options and Publishing Options, respectively. The Stage command copies translated output files to the designated staging server, while the Publish command copies translated output to the designated Publishing server. See Chapter 5 for more information.

**SETTING PROJECT AND APPLICATION OPTIONS**

Site Builder provides both project- and application-based options for handling your projects. Generally, you don’t need to worry about these during project setup. The only exception would be if you prefer to use an extension other than the default .htm for the output HTML files you create at translation.

If you do, open the Application Options dialog box from the View menu and change the entry under Default Output Extension. You should always make this change during project setup, if you can, before you add any source documents to your project. That’s because when you change this extension, the new extension is used only for source documents added to the publication after the change is made.

Note: You can set this option separately for Directory Items. You do so in the Options tab dialog of the New Directory Item Properties dialog box.

For more information on project and application options, see Chapter 6.
It isn’t necessary to designate locations for translated, staged, and published output during project setup. You can accept the default output directories for translation, if you prefer. (These vary with the operating system running on your machine. See the Introduction to the Tutorial for more information.) The more important locations for staged and published output can be set later. It all depends on how you prefer to work.

Once you are ready for the staging and publishing phases, you will also need to think about updating the content of your project, too. See Chapter 5, “The Publishing Process.”
Chapter 5

The Publishing Process

The growing sophistication of Web publishing demands an increasing commitment by enterprises. The goal is to not simply create a Web site, but to also maintain that site through constant changes. The difficulty is to not simply handle the sheer quantity of information that an enterprise may seek to publish—often intimidating in itself—but to also meet the ever-pressing challenge of updating that information without disrupting the Web site.

Key Concepts and Roles

Successful Web publishing requires the efforts of a multi-skilled team working within a clearly defined process. For the purposes of this chapter, we’ll assume a project team consisting of:

- **content author**, who is responsible for content creation (possibly with one or more reviewers responsible for approving that content)
- **project author**, who is responsible for creating the publication hierarchy, fine-tuning templates, creating navigation links, etc., and for sending the web publication to the staging server for review
- **Webmaster**, who is responsible for reviewing the Web publication on the staging server and authorizing publishing—that is, placing the Web publication on the Web site (the publishing server)

These three roles represent distinct activities in the publishing process: content creation, project creation, and staging and publishing.
The publishing process consists of:

- Creating content in Content Server (most likely using workflow to facilitate the review and final approval of individual source documents)
- Creating a project in Site Builder by adding the approved source documents to the project, creating the publication structure, setting navigation, registering the project, and so forth
- Updating and translating the Web publication you create (on a local or network drive) to test the look and feel of the publication
- Setting staging options and then actually staging (copying the translated output to the staging server)
- Reviewing the completed Web publication on the staging server (likely using “staging workflow” and “problem reports” to facilitate the approval process)
- Setting publishing options and then actually publishing (copying all translated output to the publishing server—that is, to the Web site)
The publishing process, showing the flow of content from Content Server (source server) to Site Builder, and then back to Content Server (in the form of Web pages, initially for review on the staging server and finally to the publishing server).

The above can be done manually within Site Builder. You can also use Site Server to automate the process, including both the staging and publishing of output, as we’ll see later.

Before we step through each phase of the publishing process, let’s quickly review workflow and the related concept of registration. At the start of any project, ideally you should have a clear idea of how you will use workflow in your project and how registration can contribute to an efficient publishing process.

**Note:** Much of this chapter relates closely to Chapter 4, “Project Setup in Content Server.” If you are in need of a terminology refresher, see also “Key terms” in Chapter 2.

## Workflow and Registration

Workflow is the process whereby content is created and reviewed before the finally approved version is released to a specified audience. Registration is the process of registering a project with a content server to facilitate certain tasks. Before explaining each in more detail, a word about content servers.

### Content Servers

Figure shows the ideal setup of three content servers: one for source documents (including graphics, associated files, and the project file itself), one for staging, and one for publishing. Conceivably, staging and publishing could be done on the same content server. You might even use a single content server for all three purposes. Your project could also draw files from more than one source server. (You may choose to think about these content servers differently. For example, you may prefer Contribution, Staging, and Consumption; or, Source, Development, and Production.)

**Note:** The number of content servers in use does not affect workflow or registration. In other words, the procedures you follow to register a project on a source server and a staging server are unchanged even though a single server is used for both source documents and staging. (The procedures are explained later.) Also, “staging workflow” is still possible where the source server and the staging server are the same content server.
Workflow

You can set up workflow on two different content servers, for two different purposes:

- On the source server, workflow known as “contributor criteria workflow” is set up to facilitate the review and approval of source documents for publication. This workflow focuses on content.

- On the staging server, workflow known as “staging criteria workflow” is set up to facilitate the review and approval of the output Web pages created from these source documents. This workflow focuses on the look and feel of the Web pages (content also may be addressed).

Registration

You register a project with a content server to facilitate certain tasks.

- You register a project on a source server in order to facilitate a “preview” of how a source document will look once translated and turned into a Web page.

- You register a project on a staging server to enable staging workflow and to facilitate the creation of “problem reports” for the entire Web output created when your project is staged.

Thus, workflow and registration can be used in the publishing process as follows (the shaded areas represent tasks you perform in Site Builder):

<table>
<thead>
<tr>
<th></th>
<th>On the source server</th>
<th>On the staging server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow</td>
<td>Use contributor criteria workflow for the review and approval of source documents</td>
<td>Use staging criteria workflow for the review and approval of output Web pages</td>
</tr>
<tr>
<td>Registration</td>
<td>Register a product to enable “previews” of source documents in HTML format</td>
<td>Register a product to enable staging workflow and to create a special version of the Content Information page that includes a “problem report”</td>
</tr>
</tbody>
</table>
CREATING CONTENT

In Chapter 4, you learned the basics of adding source documents to a project, versioning those documents, designating an output directory, and so forth. If you plan to take full advantage of the publishing process in Content Publisher, you will likely want to make all your source documents a part of “contributor criteria workflow” in your source server. This will ensure that a document passes through a review process before it is freed from workflow and assumes the Released state. It is explained in your Content Server documentation (including online Help).

The source documents for a given project don’t all have to be part of the same workflow. In fact, on a large project (with multiple content authors and multiple reviewers) you will likely want to set up a series of workflows according to the nature of the content, the authors responsible for specific source documents, and the reviewers responsible for approving those documents.

CREATING A PROJECT

Chapter 4 outlined the basics of handling project files in Content Server. There are additional tasks you need to consider to take advantage of the publishing process:

- Registering a Project on the Source Server (page 5-5)
- Specifying a Directory Item Setting to Facilitate Previews (page 5-7)
- Adding a Linked Publication to a Project (page 5-9)
- Setting Staging and Publishing Options (page 5-14)
- Using the Stage Command (page 5-23)

In this section, we will look at registration, restricted Directory Items, and linked publications. Later sections will address staging and publishing options, as well as automating the staging and publishing of your project.

Registering a Project on the Source Server

Registering a project on a source server allows a content author to preview a source document as it is checked into that source server. (Previews are possible any time the document is checked in.)
For previews to be possible:

- The project author must register the project on the source server
- The project author must create a “restricted” Directory Item for the source document (you can only preview a source document that is assigned to a restricted Directory Item)
- The content author must assign the source document to the restricted Directory Item at check-in (that is, assign the appropriate information in order for the document to be associated with the restricted Directory Item and for a preview to be generated based on the template associated with that Directory Item)

**Note:** Previews work only with documents in Content Server. If the source document is part of Directory Item, the Directory Item must be Restricted. In the case of a source document that is not part of a Directory Item, the preview won’t be possible until the document has been added to your project and associated with a template. So it won’t be possible the first time you check the document into the content server.

To register a project on a source server, perform these tasks:

1. With a project open in Site Builder, click **Project Registration** on the View menu to open the Project Registrations dialog box.

**Figure 5-1 Project Registrations dialog box**

![Project Registrations dialog box](image)

The Project Registrations dialog box displays all content servers that you have configured Site Builder to access. Double-click the appropriate red cross in the
Preview column to register the project currently open in Site Builder with that content server.

2. In the Registrations window, select the name of the content server in which your source documents reside and double-click the red cross opposite, in the Preview column, to turn it into a green check mark.

3. Click OK.

4. Click Save ( ) on the standard toolbar.

You have registered the project on the specified source server. To facilitate previews of source documents that are checked into the source server, you must also specify a particular setting for the Directory Items in your project (for those source documents that are part of a Directory Item).

### Specifying a Directory Item Setting to Facilitate Previews

Each Directory Item you create is, by default, of the Restricted type (as shown in the figure below). With this setting, and once a project is registered, a content author can preview at check-in any source document that is assigned document information that associates the document with a restricted Directory Item in the project.

1. Click Directory Item on the Add menu. If necessary, select Content Server as the repository.

2. In the New Directory Item Properties dialog box, click Browse to open the Directory Item Properties dialog box.

3. Click the Stellent Content Server button to open the Choose a Stellent Content server and choose a content server from the drop-down list. Click OK to return to the Directory Item Properties dialog box.
Be sure to accept the default setting Restricted (the Type field under Directory Item Information) if you want to be able to preview source documents when you check them into Content Server.

4. Under Directory Item Information, provide a name for the Directory Item.
   
   This name will be added to the content server name and will display in the Contents pane. By naming Directory Items, you will be able to differentiate between multiple Directory Items that are added to the same publication of your project and drawn from the same content server.

5. Select Restricted from the Type drop-down list (since it’s the default setting, it should be selected already).

6. In the Maximum Document Count box, enter the number of source documents you want to include in the query.
   
   The default setting is blank, which means that the query will include all source documents that meet the query criteria (up to the limit set within Content Server). But you can, if you like, limit the number of documents by entering a number in the box or using the arrows to the right of the box to set the number.
If you set a limit, the source documents used will be those listed first according to the Sort selection you made for the search in Content Server and according to whether you want the results listed in ascending or descending order.

7. Create a query in Content Server. Once you click the Add Query to Project button, you’ll return to the Directory Item Properties dialog box.

8. Click OK.

Please note the following:

- When you create a restricted Directory Item, you must select Restricted (step 5) before you create the query (step 7).
- You cannot conduct a full text search to create a restricted query. (You can use only document information for the search, not document content.)
- To change a standard query to a restricted query, you must re-specify the query.

**Adding a Linked Publication to a Project**

Just as you can add a Directory Item as a subpublication to a project, so, too, you can add another project. When you add one project as a subpublication to a second project, the first project becomes a linked publication (or subproject) and the second project becomes the master project. Each time you run a translation of the master project, the contents of the linked publication are translated, too.

However, to change a linked publication, you must open the linked publication by itself in Site Builder. And the next time you open the master project, you must be sure to use Update Versions before translating so that the changes made to the linked publication are reflected in the translation of the master project.

Linked publications can be especially useful in large projects where a heavy workload and complex publication hierarchy demand multiple project authors (and multiple content authors). The lead project author can be responsible for the master project, with other project authors handling portions (linked publications) of the master project.

To add a linked publication, perform these tasks:

1. With your project open in Site Builder, select the subpublication in the publication hierarchy that will contain the linked publication.
2. Click **Publication** on the Add menu to open the Add Publication dialog box.
3. Click the **Linked Publication** button, and in the Open dialog box locate the project file for the project you want to add as a linked publication.
4. Select the project file and click **OK** to return to the Add Publication dialog box.

   The publication name of the project is used for the name and title of the new subpublication you have just created for the linked publication. It is also used for the subfolder of output directories. You can change this, if you want.

5. Click **OK**.

You have now added a linked publication, which appears as a subpublication of the publication originally selected. Both the linked publication (in the Publication Hierarchy pane) and its contents (as displayed in the Contents pane) are grayed out to signify that you cannot edit a linked publication while it is part of a master project. The linked publication must be maintained separately, and opened by itself in Site Builder to be updated.

**Note:** You can convert a linked publication into a regular publication at any time. Right-click the linked publication in the Publication Hierarchy pane and choose **Make embedded** from the popup menu. Click **Yes** in the dialog box that appears. The publication is now a permanent part of the master project and its contents can be edited like those of any other subpublication. (The project file for the linked publication still exists in its original location and can be used for other purposes, if you want.)

---

**UPDATING SOURCE DOCUMENTS**

Once you have completed project setup and have your publication hierarchy in place, you can begin testing template settings, navigation, and so forth. During this phase of the publishing process you are translating the project to a local or network drive and are therefore involved with the three-step sequence of **Update-Translate-View**.

Once you are satisfied with the structure and formatting of your publication, you are ready to stage your output, that is, copy your translated output from the file system to a staging server so that you can formally review your Web pages before publishing the content to a Web site. Later still, you will finally publish to the Web site. So the complete sequence is **Update-Translate-View-Stage-Publish**.

You will want to use the Update Versions command as you create your project. You won’t necessarily want to use the command before each translation, but you will certainly want to use it at critical times during project creation to be sure that what you are reviewing contains the latest content. This obviously becomes more important during staging, and more important still before you finally publish.

The Update Versions command is important because when you add source documents to a publication, you don’t, in fact, check out those documents from Content Server. Rather,
Site Builder obtains working copies of the versions current at the time the documents were added to the project and uses those copies for translation. As a result, someone else may check out—and change—those same files by the time you’re ready to stage and publish.

**Update Versions Command**

When you click Update Versions, Site Builder reviews the status of all source documents in the source server and identifies any that have been checked out and revised since you first added them to your publication. It uses copies of the latest released versions of those documents for all subsequent translations (until you click Update Versions again).

Clicking Update Versions on the toolbar updates *all* documents in your publication, no matter what is selected in the Publication Hierarchy or Contents pane. Alternatively, you can update all documents by selecting the root publication, right-clicking, and choosing Update Versions from the popup menu that appears.

Likewise, to update selectively, select only the appropriate subpublication in the Publication Hierarchy pane or the Directory Item or document in the Contents pane. Then right-click and choose Update Versions from the popup menu. In that event, Site Builder will check for new versions of only those source documents included in your selection. (You can select multiple documents by using Ctrl with the mouse button.)

**Updating a Linked Publication**

A linked publication cannot be changed from within a master project. It must be opened separately, by itself, in Site Builder, and the Update Versions command used to update the contents of the project. Once a linked publication is updated, you must use the Update Versions command the next time you open the master project in order for changes to the linked publication to be reflected in the master project.

**Updating Projects on Site Server**

Updating occurs automatically when you schedule a project for translation on Site Server. For more information, see “Publishing in Site Server,” in Chapter 3.
Specifying a Version of a Source Document

You may not always want to use the latest released version of a particular document. If you prefer to specify a particular version to use all the time, the document will not be subject to updating by the Update Versions command and the specified version of the document will be used each time you translate.

Specifying a Specific Source Document Version for Translation

To specify a particular version of a source document for translation, perform these tasks:

1. In the Contents pane, select the source document you do not want to be updated by the Update Versions command.
2. Right-click the document and choose Properties from the popup menu to open the Document Properties dialog box.
3. Click the Information button to open the Document Details dialog box.
4. Scroll down through the list of versions available and in the Revision column click the version number for the version you want to use. You can select any document on the list, no matter its Status.

Figure 5-3 Document details

The Document Details dialog box, where you can specify a particular version of a source document to be used for your Web publication. The Allow refresh to latest released version check box (at the top of the dialog box) is checked by default, thus
ensuring that the latest released revision of a source document is always used, unless you specify otherwise.

5. At the top of the dialog box, clear the **Allow refresh to latest released version** check box.

6. Click the **Select** button to return to the main window.

An asterisk after a document name in the Contents pane signifies that the document will be updated when you click Update Versions. So when you specify a particular version of a source document from Content Server, that document no longer has an asterisk after it in the Contents pane. Since Update Versions doesn’t apply to documents from the file system, those documents don’t have an asterisk after their name, either.

This project contains a source document from the file system and a Directory Item and source document from Content Server. If the source document from the file system is updated, it will automatically be included in the next incremental translation. You cannot tell when a Directory Item needs to be updated. As a result, you should always use the Update Versions command before you translate projects that contain a Directory Item. The asterisk after the second source document is a reminder that you should use this command with single source documents from the content server, too.

### Specifying the Latest Released Version of a Source Document for Translation

The default behavior in Content Server is for the latest released version of a source document to be used each time you translate. Thus, each time you enter the Document Details dialog box, the **Allow refresh to latest released version** check box is selected. If you have selected a specific revision for publishing, you may in the future want to revert to using the latest released version of this source document in your project.

1. With your project open in Site Builder, right-click the appropriate source document in the Contents pane and choose **Properties** from the popup menu.

2. Click the **Info** ( ) button to open the Document Details dialog box.

3. Select the **Allow refresh to latest released version** check box.

4. Click the **Select** button to close the Document Details dialog box.
Each time you choose the Update Versions command, Site Builder will use the latest released version of this document when you translate and publish in future.

**STAGING A PROJECT**

Staging a project is the process whereby the project author copies translated output from the file system to a staging server for the Webmaster to review before the finally approved content is published to the Web site (the publishing server).

You can, in fact, by-pass staging and go straight to publishing. But a review is advisable if only because there likely will be some features of your Web site that you can check only once you have staged (or published) your project.

For example, staging offers you the first chance to check any Query reference pages or dynamic content in your project. It also provides an opportunity to inherit document information from source documents and place it in output Web pages and to check conditional disclosure for the first time.

**Benefits of Staging**

Generally, it is wise to stage your project. If you choose to stage, you can do three things independently: create staging criteria workflow, register the project to facilitate the creation of “problem reports,” and add a special icon to each Web page to provide direct access to the Content Information page.

You can thus create problem reports without creating staging workflow—and workflow without problem reports. You can also stage without using either workflow or problem reports (or placing the special icon on output pages).

**Setting Staging and Publishing Options**

You must set staging options in order to stage your project. The staging options you set apply only to staged output. Once you have reviewed your staged Web publication and are ready to publish, you must set publishing options for your published output. (Although you set the options separately, you should generally set them the same way.)

- If, for a particular project, you set only staging options or only publishing options, any property values and security settings you choose to inherit will be inherited directly from the source documents.
The Publishing Process

- If you set *both* staging and publishing options, the values and settings you inherit for published output will come from your staged output (which will have obtained them from the source documents).

- If, however, you set both staging and publishing options but only publish—don’t first stage—your project, then your output pages will not be able to inherit property values and security settings. Site Builder (or Site Server) will try to inherit them from the staged output. It will fail to do so and will generate a publishing error.

You set staging options by completing the following tasks. The first two are required:

1. Identify the staging server, that is, the content server you want to use to stage your translated output.

2. Specify document information to be used, by default, for all output Web pages so that your output can be checked into the staging server (required, even if you choose to inherit properties from source documents, to ensure that those pages that do not originate in the source server are assigned document information).

3. Specify properties you want your body pages to inherit from their source documents instead of using the default document information (optional).

The document information you specify is default information that will be used for all output pages, in particular, files for frames, TOCs, etc., that are built by Site Builder and do not have their origin in Content Server. If you specify property values and security settings that you want your body pages to inherit from their source documents, the inherited values will prevail for all body pages.

Example: If the name of Author A is inherited from a source document and the name of Author B is specified for the output pages generated from that source document, only the name of Author A will be retained by Content Server.

4. Register the project on the staging server to facilitate workflow (optional).

5. Suppress placement of the special Info icon on output Web pages (optional).

6. Generate document names from file names if you would like to publish to the content server without a unique suffix (optional). When this option is selected, only the file name, with its prefix (if added), is published to the staging server. This is used most often when adding a prefix to output file names to help generate predictable file names.

7. Set check-in file extensions if you would like to check in files with an extension other than the default *hcsp* when you publish to the staging server (optional).

Let’s examine each task, in turn.
**Designating the Staging Server**

The first task is to designate the content server to be used for staging. As mentioned before, you can, in fact, use the same server for staging as for source. In fact, you can use the same server for all three purposes: source, staging, and publishing.

1. With your translated project open in Site Builder, click **Staging Options** on the Run menu to open the Staging / Publishing Options dialog box.

**Figure 5-4**  Staging/publishing options

In setting staging options, the first step is to designate a content server for staged output. The one chosen for Pages will be used automatically for Graphics and Gallery Graphics.

2. Click the **Browse** button opposite Pages to open the Publish Properties dialog box (see Figure):
Figure 5-5  Staging options

The Staging Options dialog box, where you complete two required tasks for staging and can also complete several optional settings.

3. Click the **Stellent Content Server** button to open the Choose a Content Server dialog box.
Choosing a content server

All the content servers your machine is connected to are available from the drop-down list.

4. From the drop-down list, select the content server you want to use for staging, and click OK to return to the Publish Properties dialog box.

**Note**: The same content server is now designated for all three types of output: pages, graphics, and Gallery graphics. You can use different content servers for the other two, if you want, though this is unlikely to be useful.

### Specifying Document Information

The second task is to specify document information to be used by default for all output pages.

Not all the Web pages in your Web publication are based on content in the source server. Part of your publication will consist of files for frames, reference pages, etc., that are generated by Site Builder during translation. Since these output pages can’t inherit from source documents, you must specify document information so that these files can be checked into the content server that is used for staging.

This document information will be used, by default, for body pages, too—unless you designate property values and security settings to be *inherited* from the source documents (see next task).

1. Click the **Document Information** button to open that dialog box.

2. Change or complete the other fields to set the document information you want to associate with the staged output. This can include custom document information specific to an organization.
The Document Information dialog box, where you specify properties for staged output. The dialog box can be customized to include additional fields.

3. In the Expiration Date text box, you might enter a date on which all the staged output should be automatically removed from the Web site. (This same dialog box is used for publishing, and this option makes more sense there.)

4. Click the Assign Info button to return to the Staging Options dialog box.

**Specifying Properties to Inherit**

The third task is to decide which property values and security settings you want your output pages to inherit from source. If you don’t specify any here, the default document information you specified in the previous task will be used for all output pages checked into the content server used for staging.

1. Click the Inherited Settings button to open the Inherited Document Information dialog box.
The Publishing Process

**Figure 5-8** Inherited documentation information

<table>
<thead>
<tr>
<th>Field Caption</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>dDocAccount</td>
</tr>
<tr>
<td>Author</td>
<td>dDocAuthor</td>
</tr>
<tr>
<td>Title</td>
<td>dDocTitle</td>
</tr>
<tr>
<td>Type</td>
<td>dDocType</td>
</tr>
<tr>
<td>Security Group</td>
<td>dSecurityGroup</td>
</tr>
<tr>
<td>Release Date</td>
<td>dlnDate</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>dOutDate</td>
</tr>
<tr>
<td>Comments</td>
<td>xComments</td>
</tr>
<tr>
<td>CustomMedia</td>
<td>xCustomMedia</td>
</tr>
</tbody>
</table>

An output page can inherit from its source document all of the metadata shown in the Inherited Document Information dialog box.

2. Select the appropriate check boxes to identify those properties in your source documents that should be inherited by the output pages you create.

3. Click **OK** to return to the Staging Options dialog box.

Please note the following:

- The staging options you set apply only to staged output. Once you have reviewed your staged Web publication and are ready to publish, you must set publishing options for your final output.
- Your publishing options can therefore be different from your staging options. This may be useful, for example, if you want to inherit security settings from source documents that will prevent certain users from viewing certain pages on the Web site.

**Registering the Project on the Staging Server**

The fourth task is to register the project on the staging server in order to facilitate staging criteria workflow. Doing so will also result in the creation of the special Content Information page containing a problem report section that can be used by the reviewer to
send a report to the content author and project author highlighting a problem with a particular Web page.

**Note:** You can only register a project that has been saved to Content Server. (The option is grayed out otherwise.)

1. On the Publish Properties dialog box, select the check box **Register the project with the Stellent Content Server for staging workflow.**
2. Click **OK** to close the Staging Options dialog box and return to the Staging / Publishing Options dialog box.

The project will remain registered as long as you continue to stage to the designated content server or clear this check box.

**Suppressing the Info Icon on Web Pages**

You can decide whether you want to use the special Info icon (�建) on every Web page of your staged output. This icon provides access to the Content Information page for a Web page, including the special problem report section (if you have registered the project). By default, it is added to every Web page of your stage output.

You don’t have to use the Info icon when you stage. For example, you may decide to use it initially when you first stage your project, and then decide later to leave it off when you feel that your staged version is almost ready to be published. At that time you will be able to view your Web pages exactly as they should appear on your Web site.

- In the Staging Options dialog box, select the **Suppress placement of Info buttons on staged output** check box.

  The Info icon will be removed from your Web pages the next time you stage the project.

**Note:** Each time you change this option, Site Builder automatically rebuilds your entire staged output, even if you have changed only one or two source documents since the last time you translated the project.

Now that you have completed staging options, the time has come to actually stage the project.

**Generating Document Names From File Names**

When files are staged or published to Content Server, by default Content Publisher appends a unique suffix to each file name when the file is checked in. This ensures file name uniqueness within the content server. If you prefer, you can publish to the content
The Publishing Process

server without the unique suffix. You may want to use this in conjunction with the prefix option so that you can more easily recognize and predict the file name.

- Under Document Name, select Generate document names from file names. When this option is selected, only the file name, with its prefixes (if added), is published to the content server, such as P34document.hcsp. When this option is not selected, the unique suffix is appended to the end of the file, such as P34document_ia937498-2.hcsp.

**Note:** This section describes project-level settings. This option is also available at the publication, Directory Item, and document levels.

**Setting Check-In File Extensions**

You can specify the file extensions that Site Builder assigns to files when checking documents into the content server during staging or publishing. This allows flexibility in determining the final URLs of published documents.

You can specify that either the extension created during translation or a file extension you specify is used during check-in. If using a specific extension, most often you will want to accept the default, which is hcsp.

Note: When publishing Query Pages, you should ensure that an hcsp extension is used, as those pages must contain the hcsp extension when checked into the content server.

You can specify file extensions for check-in to the content server at the project, publication, Directory Item, and document levels.

- Under File Extensions, do one of the following:
  - If you want to check in files using the extension generated during translation, click Check in documents using original file extensions.
  - If you want to specify the file extension, click Check in documents using this file extension, and enter a file extension containing up to 8 characters in the text box.
  - If you want to check in files using the default hcsp extension, ensure the Check in documents using this file extension is selected and the hcsp extension displays in the text box. This is the default file extension used when you check files into the content server.

**Note:** The file extensions set in staging options should be the same as the extensions set in publishing options.

This option is also available for Directory Items and documents. To set file extensions for either a Directory Item or document, open the Publishing Options tab dialog in the
appropriate Properties dialog box, which is available after you set staging or publishing options. Set the extensions by following the instructions described above.

**Using the Stage Command**

Once you have set staging options, as explained above, you are ready to stage the project.

1. Click **Stage** on the Run menu.

   Once you specify locations for your output files, each time you click Stage, the Confirm Staging Options dialog box will open, to ask you to confirm your options.

   ![Figure 5-9 Confirming staging options](image)

   The Confirm Staging Options dialog box, containing information specified in the Staging Options dialog box.

2. To accept the information, click **OK**. Site Builder will stage the project. To change any information, click **Cancel** and return to the Staging/Publishing Options dialog box.

   **Note:** If, when you click Stage, you haven’t already specified the required information, the Staging/Publishing Options dialog box will open instead.

When you click **OK**, Site Builder copies all translated output from your file system to the staging server. If your Web publication includes Query reference pages, these will be active for the first time on the staging server. And if you have decided to create staging workflow (and have registered the project), workflow will begin as soon as the project is staged.

Remember: It’s always wise to update (and re-translate) your project before you stage. (See “Updating source documents,” above.)
The Publishing Process

Fine-Tuning Property Values and Security Settings

When you complete staging options for a project, you are treating all of your publication the same way for the output location selected. That is, the same property values and security settings (whether specified or inherited) will be applied to all output pages and graphics for a given output location.

This may be fine for your purposes. If you prefer, and as noted above, you can select a different output location for graphics and/or Gallery graphics and set property values and security settings unique to those output files.

Yet another option is to fine-tune your Web publication by specifying different property values and security settings for individual subpublications or documents in your project. This is possible only after you have set staging (or publishing) options.

Let’s take a simple example of changing the settings for a single document.

To override property values and security settings for a document, perform these tasks:

   
   The dialog box now has a Publish Options tab. This tab displays only if you have already specified output locations (in the Staging Options or Publishing Options dialog box).

2. Click Publish Options to open that tab dialog.
The Publish Options tab dialog is available in the Publication Properties and Document Properties dialog boxes once you have set staging or publishing options for the project.

You have two sets of options: pages and graphics. And within each, you have the opportunity to edit property values and security settings that will override those set for the publication as a whole in Staging or Publishing Options. (In each case, the Clear button will simply clear whatever property values or security settings have been entered. In that event, the values and settings will revert to whatever is set at the next highest level in the hierarchy.)

The No Overrides entries signify that no property values or security settings have been specified for this source document (those set in Staging or Publish Options for the Web publication are to be used).
3. Under Pages, click the **Edit** button opposite Properties to open the Publishing Options dialog box.

**Figure 5-11** Publishing Options dialog box

![Publishing Options dialog box](image)

You can open the Publishing Options dialog box by clicking Edit on the Publish Options tab in the Properties tab dialog for subpublications and individual source documents.

This is the same dialog box you saw when you first set staging options (except that you cannot change the content server and the option to register the project is not available).

Now, you can set property values for the selected document that will override those values set for publication as a whole.

Please note the following:

- Once staging or publishing options have been set in the Publish Options dialog box, the Publish Options tab shown in the figure above is now available for subpublications, too, so you can fine-tune property values and security settings for those in the same way.
When you set publish options in a subpublication or individual source document, these options override options that have been set at a higher level in the hierarchy. Typically, this will mean that they override options set in the Publish Options dialog box for the publication as a whole. Conceivably, however, you could set options for a subpublication that are different from the project options, and then set options differently for a source document within that subpublication.

Although the Publishing Options tab is available for the root publication (as well as all subpublications and source documents), you should ignore it (except for linked publications). You must always use the Publish Options dialog box to set publish options for the publication as a whole.

Gallery graphics are dealt with only at the project level.

**Publishing a Project**

Publishing a project isn’t very different from staging one. In fact, you could, if you like, “stage” directly to your Web site. As long as you suppress the Information icon on the output Web pages, you will end up with the same results as you would if you had published directly to your publishing server. (However, you shouldn’t “stage” to a publishing server if you have already staged to a staging server. See Note 1, below.)

So setting publishing options is very similar to setting staging options (you work through a similar set of dialog boxes, as explained above). But remember: If you set both staging and publishing options but only publish—don’t first stage—your project, then your output pages will not be able to inherit property values and security settings. Site Builder will try to inherit them from the staged output. It will fail to do so and will generate a publishing error.

**Note:** Although you set staging and publishing options separately, you should generally set them the same way. The essential difference is that you cannot register the project on the publishing server or place the Information icon on output pages.

When you use the Publish command, Site Builder copies translated output from the file system to the content server designated for publishing (the publishing server on which your Web site exists). You shouldn’t be updating between staging and publishing, because if something has changed, you probably want to translate your Web publication one more time and also stage it again before finally publishing.
Please note the following:

- Although you may stage directly to a publishing server, you shouldn't do so if you have already staged to a staging server. In other words, having set up your staging options, you shouldn't try to redirect your staged output to the publishing server by simply changing the server you want to “stage” to. Not only will you not be able to publish, you will delete all staged output on the staging server.

- The expiration date on a staged or published file governs the expiration date of a Web page. That date is either the date inherited from the source document used to create the Web page (see “Inheriting document information”) or the date used when you specified document information (see “Setting staging options” and “Setting publishing options”).

- The check-in of a Web page on the staging or publishing server will fail if the expiration date is earlier than the release date. The release date is either the date inherited from the source document or the date applied when you specified document information (see Note 2).

- Site Builder stages and publishes incrementally. Say you have already staged or published and decide to update source documents and therefore the translated output. When you re-translate your project and then stage or publish again, Site Builder will copy only the revised output files to the location designated for staged or published output. It will preserve the original Content IDs in the process.

- The Update Versions, Translate, Stage, and Publish commands work differently when you schedule a publication for translation by Site Server. See Chapter 3 for more information.

**AUTOMATING STAGING AND PUBLISHING**

You can use Site Scheduler to automate the staging and publishing of your Web publication by scheduling your project to run on Site Server.

If you want to both stage and publish the same project, you’ll want to leave some time between the staging of the project phases in order to allow time for the Webmaster to review output on the staging server. This is especially so if you use staging workflow as part of the review process for staged output.

As explained in Chapter 3, you can achieve this by setting up two tasks for the same project.
Chapter 6

SETTING PROJECT AND APPLICATION OPTIONS

During project setup you may set options that can affect your output in a number of ways. You can always accept the default settings—they will be fine in most instances. And whatever options you set at any time, you can later change at any time. But you should be aware of the options available in Site Builder.

Site Builder distinguishes between two types of options, as represented by two dialog boxes: Project Options and Application Options.

- “Project options” are saved with the project file. Changes apply only to the project open in Site Builder at the time of the change.
- “Application options” are user-specific for a given machine. If multiple users share a machine and set different options, the options in effect will be those that have been set by the user who is currently logged on.

PROJECT OPTIONS

To review project options, click Project Options on the View menu to open the Project Options dialog. This dialog has the four tabs:

- General (see page 6-2)
- File Naming (see page 6-3)
- Map File / Print Publication (see page 6-4)
- Repositories (see page 6-5)
If you change any settings, the new settings will be saved to the project file and will apply to the current project only.

**General Settings**

The General tab of the Project Options dialog enables you to set options that are saved with the project file. That is, the settings move with the project and will apply, for example, if you schedule the project for translation by Site Server.

**HTML generation**—Standard HTML (Latin-1) is supported by HTML. The optional Windows-specific character set offers a richer set of characters, but is advisable only if you know your users can display all the characters in their browser. (This option isn’t appropriate, for example, with Unix-based browsers.) These options should be used in conjunction with Output Character Set.

**Output Character Set**—The default set is Western (ISO-8859-1). Unicode (UTF-8), which is supported by HTML 4.0, offers the broadest range of characters for all browsers, except older ones (version 2.0 and earlier). It includes all the characters offered by the other options.
Containing frame name—Used when your Web publication will become part of an existing Web publication. In that event, you should replace _top with the name of the frame your Web publication will open in (otherwise, your publication will take over the whole browser window). All names used will be saved to the project file and will be available from the drop-down list in future.

Publish with errors—Used to publish with errors even when Site Builder encounters problems during translation. The option is turned off by default. The option is designed especially for situations where a file in an unsupported format inadvertently has been added to a Directory Item. With this check box selected, Site Builder will simply skip this file and complete the translation and publishing process as if the file wasn’t in the Directory Item at all. (Its failure to translate the file will be noted in the Log file.)

No Script Support—Add any text to be displayed in your browser when an output page contains scripts and the browser does not support them.

Note: The addition of text for No Script Support isn’t generally required, because Web publications built with Site Builder will still function when scripting is turned off. The only time you might want to use this feature is when you have created a Web publication that includes the Print button and you are not certain that all users will be able to use this functionality successfully.

File Naming Options

The File Naming tab of the Project Options dialog contains the following options:

File names—An important setting where case sensitivity is an issue. Typically not an issue in a Windows environment but always an issue if you have a Web site running on a Unix-based server. If that’s the case, you should select Force all names to lower case.

Output name prefix—Used to add a prefix to your staged or published output to help create predictable file names when publishing to Content Server. Using this option, you can more easily distinguish between published files in different projects.

Prefixes can be added at the project, publication, and Directory Item levels. Site Builder adds the prefixes to the output files during translation. With this feature, you can use the same source document in multiple publications of the same project.

Example: You could add document.doc to both Publication A and Publication B of a project if you apply a prefix to the output file in one of the publications. If you add a “test” prefix to Publication A, during translation that file becomes testdocument.htm, while the output file name for Publication B remains document.htm.
You can add multiple prefixes in a project. Prefixes are appended to each other, and the prefix assigned to the closest publication always takes priority over other publications.

For example, your publication hierarchy and prefix settings are as follows:

<table>
<thead>
<tr>
<th>Level</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>P</td>
</tr>
<tr>
<td>Publication 1</td>
<td>1</td>
</tr>
<tr>
<td>Publication 2</td>
<td>2</td>
</tr>
<tr>
<td>Publication 3</td>
<td>3</td>
</tr>
<tr>
<td>Directory Item 4</td>
<td>4</td>
</tr>
</tbody>
</table>

Using the above example:

- If you set prefixes for the Project, Publication 3, and Directory Item 4, the complete prefix appended to output files for the documents contained in the Directory Item would be **P34**.
- If you set a prefix for the Project, Publication 2, Publication 3, and Directory Item 4, the complete prefix for the documents contained in the Directory Item would also be **P34**, since Directory Item 4 is not directly related to Publication 2.
- If you set a prefix for Publication 3 and Directory Item 4, without setting any other prefixes, the complete prefix for the documents contained in Publication 3, except Directory Item 4, would be **3**. The complete prefix for items contained in Directory Item 4 would be **34**. There would be no prefix associated with items contained in the Project through Publication 2 levels.

The Map File / Print Publication tab dialog contains additional settings that are also saved to the project:

**Map File and Print Publication Options**

The Map File/Print Publication tab of the Project Options dialog shows the default settings that are essential for creating an XML Map file and enabling the Print functionality.
Figure 6-2  Project Options dialog (Map File/Print Publication tab)

**Map file**—An XML file that describes the output of your project on your Web site. By selecting the second check box—**Map file contains source file details**—the Map file will reveal the hierarchy of your source documents. Site Builder generates the Map file by default. It is required in order to enable the print functionality.

**Print publication**—Necessary for identifying the script to be used in order for the Print icon (selected in **Navigation**) to work. Automatically entered by Site Builder.

**Repository Options**

There are two options on the Repositories tab dialog of the Project Options dialog: **Output page naming** and **Conditional disclosure**. With standard naming (the default), Site Builder simply takes the source document name and changes the extension to produce the output HTML page. Thus, Tutor.doc becomes Tutor.htm. The optional settings are relevant when using a content server. The **Enable conditional disclosure** option allows you to enable conditional disclosure in Content Server, that is, to display only content relevant to the end user’s security. (See your Content Server documentation for more information.)
APPLICATION OPTIONS

To review application options, click Application Options on the View menu to open the Application Options dialog box.

Application options are user-specific on a given machine. If they are changed by a particular user, the new settings will apply to all projects run on the machine by the user logged on at the time of the change.

Logging Options

Figure 6-3 Application Options dialog (Logging tab)

You can set the following option on the Logging tab of the Application Options dialog:

Logging—The translation log for your project. You can change the path and file name for the log file, if you want, and also the logging level. The default is Level 4. Level 5 provides the most complete logging information. The log file will be reset after each translation (Site Builder will create a new log file by writing over the old one), unless you change this setting. Note that you can produce the log file in either the HTML format (the default) or text format.
General Options

You can set the following option on the General tab of the Application Options dialog:

**Word processor default character style name**—Important when you are using Microsoft Word. Default Paragraph Font is the name of the default character style in Word that provides the font for the underlying paragraph style of all styles in every Word template. Site Builder recognizes this name and does not import the style. As a result, you can format your publication without fear of the default character style overriding your settings.

If you are using a version of Word in a language other than English, you need to enter the equivalent of Default Paragraph Font in this text box. Any entry you make will be saved and will be available from the drop-down list in future.

**Default output extension**—Generally, you will always want to use either **htm** (the default) or **html** as the extension for your output HTML pages. Ideally, any change to this setting should be made during project setup, because the change will apply only to new source documents added to the project after the change is made. (The **wml** extension would be used for any WML projects you create. For more information on WML projects, see “Creating a WML Project,” a PDF manual to be found in the Documentation folder of your installed directory.)
Note: By default, the hcsp extension is used when output pages are checked into a content server. However, you can use htm (or html), if you prefer. See “Setting staging options” in Chapter 4.

The General tab dialog, where you specify the Default Paragraph Font for the language version of your word processor, change the default output extension, and also set the default output extension for your projects. The option to change the default language is only available if you have installed more than one language version of Content Publisher.

**Default output file names**—The default setting is to use the file name of the source document for the output file name. Click Use this property for file naming if you prefer to use a metadata property (e.g., dDocAuthor or dDocTitle) for files from the content server. You can also choose to strip the file extension from the original file name at the same time.

**Language**—This option let’s you choose the default language you want to work in. The option is available only if your Installer allows you to install French and German versions of Content Publisher in addition to the English-language version, and you choose to install any two or all three language versions.

**Note:** When you change the default language, you must also change it in Site Scheduler and Site Server. For more information, search for “default language” in the Index of online Help to open the topic “Changing the default language.”

**Dialog Options**

![Figure 6-5 Application Options dialog (Dialogs tab)](image-url)
This dialog lets you toggle between showing and hiding various screens and cautions in Site Builder.

Most are turned on by default when you first install Site Builder. The only exception is the **Show Project Type selection dialog** check box. You can use this check box to toggle between creating an HTML or WML project. When you select this check box, the next time you start a new project in Site Builder, the New Project Type dialog box will open, to let you choose between starting an HTML project or WML project.

With **Show Selective Incremental Translation dialog** selected, you can right-click a publication in the Publication Hierarchy pane and choose **Translate Publication** from the popup menu to open the Selective Incremental Translation dialog box. Here, you can select individual publications and files to be translated. (TOCS do not appear in this dialog box, because TOCS—and framesets—are always updated with each translation.)

You can also open this dialog box by right-clicking an individual source document in the Contents pane and choosing **Translate Selected** from the popup menu. In either case, you can confirm (or change) your selection before translating.

### Site Server

Unless you are using Site Builder as a standalone workstation, you are most likely using the server, Site Server, to automate the translation process. By saving all the project options listed above to your project file, all the options that affect output can now travel with the project when you schedule it for translation by the server. That’s also true if you move the project and run it on any machine other than the one on which it was created.

### Viewer Options

Let’s quickly review the viewer options. You need to have Microsoft Internet Explorer version 4.0 or higher installed on your machine in order for Site Builder to run the Preview windows found in the Choose Template and Edit Template dialog boxes. (You can ask the Installer to install version 5.5 during installation. If you need to install the browser after installation, double-click **cdsetup.exe** in the ..\Support\Internet Explorer folder on the CD-ROM.)

These preview windows show only a temporary translation of the source document that you are editing. Since some effects are browser-dependent, the Web page you see in the Preview window in these two dialog boxes may not match exactly the Web page you view in your Web browser once you formally translate the source document.
Whichever viewer you set as your default viewer will open whenever you formally translate your source documents and click the View button on the large toolbar to view the Web publication you’ve just created. You can associate additional Web browsers with Site Builder and have all of them available for use. And you can easily switch between browsers to view your Web publications. You can also associate utilities such as Notepad. To add viewers, choose Setup from the Viewers menu, and then click Add in the Viewers Setup dialog box to locate and select the executable of the browser you want to use (see Figure 6-6).

All the browsers you select for use in Site Builder are available from the Viewers menu. You can also right-click the View button on the large toolbar to choose a browser from the popup menu that displays your viewer options. And you can choose Launch Viewer from the Viewers menu to launch your default viewer.

If your publication is unframed, you can view a specific source document in your browser by selecting that document in the Contents pane and then clicking View. (If none is selected, the browser will display the first document in your publication.) If your publication is framed, the browser will display the frameset for the publication selected in the Publication Hierarchy pane. (It will open the first body page of the frameset, no matter which source document is selected in the Contents pane.) If no publication is selected, the browser will display the frameset of the root publication.

Figure 6-6  Viewers Setup dialog box.
Site Builder translates source documents from major word processing, spreadsheet, and presentation software programs, as well as those in other common file formats. It converts graphics in many different formats. In fact, Site Builder can convert about 225 different document and graphics formats.

In addition, Site Builder accepts input files in HTML, XML, and PDF formats. For more information on how Site Builder treats these files and recognizes them in your Web publication, see “HTML, XML, and PDF as input files.” And for information on how a graphic can be added to a publication as a source file, see “Graphics as input files.”

You may also want to preserve files that are in special formats that you use to create your Web site. Site Builder can pass through such files without modification and place them in the appropriate output directory so that they are recognized as part of the project. They can then be referenced from within the project and even promoted to a publication’s TOC. See “Passing through source documents without conversion,” below.

**FILE FORMATS**

Content Publisher can translate over 225 file formats. The following table lists the major text formats supported.

<table>
<thead>
<tr>
<th>Application / Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word processing - DOS</td>
<td></td>
</tr>
<tr>
<td>ANSI Text (7 &amp; 8 bit)</td>
<td>all versions</td>
</tr>
</tbody>
</table>
### File Formats and Translation

<table>
<thead>
<tr>
<th>Application / Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII Text (7 &amp; 8 bit)</td>
<td>all versions</td>
</tr>
<tr>
<td>DEC WPS Plus (DX)</td>
<td>through 4.0</td>
</tr>
<tr>
<td>DEC WPS Plus (WPL)</td>
<td>through 4.1</td>
</tr>
<tr>
<td>DisplayWrite 2 &amp; 3 (TXT)</td>
<td>all versions</td>
</tr>
<tr>
<td>DisplayWrite 4 &amp; 5</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Enable</td>
<td>3.0, 4.0, 4.5</td>
</tr>
<tr>
<td>First Choice</td>
<td>through 3.0</td>
</tr>
<tr>
<td>Framework</td>
<td>3.0</td>
</tr>
<tr>
<td>HTML</td>
<td>through 3.0</td>
</tr>
<tr>
<td>IBM FFT</td>
<td>all versions</td>
</tr>
<tr>
<td>IBM Revisable Form Text</td>
<td>all versions</td>
</tr>
<tr>
<td>IBM Writing Assistant</td>
<td>1.01</td>
</tr>
<tr>
<td>Lotus Manuscript</td>
<td>through 2.0</td>
</tr>
<tr>
<td>MASS11</td>
<td>through 8.0</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>through 6.0</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>through 2.0</td>
</tr>
<tr>
<td>MultiMate</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Navy DIF</td>
<td>all versions</td>
</tr>
<tr>
<td>Nota Bene</td>
<td>3.0</td>
</tr>
<tr>
<td>NovellWordPerfect</td>
<td>through 6.1</td>
</tr>
<tr>
<td>Office Writer</td>
<td>4.0 through 6.0</td>
</tr>
<tr>
<td>PC-File Letter</td>
<td>through 5.0</td>
</tr>
<tr>
<td>Application / Format</td>
<td>Version</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>PC-File+ Letter</td>
<td>through 3.0</td>
</tr>
<tr>
<td>PFS:Write</td>
<td>A, B, C</td>
</tr>
<tr>
<td>Professional Write</td>
<td>through 2.1</td>
</tr>
<tr>
<td>Q&amp;A</td>
<td>2.0</td>
</tr>
<tr>
<td>Samna Word</td>
<td>through IV+</td>
</tr>
<tr>
<td>SmartWare II</td>
<td>1.02</td>
</tr>
<tr>
<td>Sprint</td>
<td>1.0</td>
</tr>
<tr>
<td>Total Word</td>
<td>1.2</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>all versions</td>
</tr>
<tr>
<td>Volkswriter 3 and 4</td>
<td>through 1.0</td>
</tr>
<tr>
<td>Wang PC (IWP)</td>
<td>through 2.6</td>
</tr>
<tr>
<td>WordMARC</td>
<td>through Composer+</td>
</tr>
<tr>
<td>WordStar</td>
<td>through 7.0</td>
</tr>
<tr>
<td>WordStar 2000</td>
<td>through 3.0</td>
</tr>
<tr>
<td>XyWrite</td>
<td>through III Plus</td>
</tr>
<tr>
<td>Word processing - Windows</td>
<td></td>
</tr>
<tr>
<td>Adobe FrameMaker (MIF)</td>
<td>6.0</td>
</tr>
<tr>
<td>Corel/Novell WordPerfect</td>
<td>through 12.0</td>
</tr>
<tr>
<td>Hangul</td>
<td>2002 (full conversion)</td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
<td>5.0, 6.0, 8.0 through 13.0, 2004</td>
</tr>
<tr>
<td>JustWrite</td>
<td>through 3.0</td>
</tr>
<tr>
<td>Legacy</td>
<td>through 1.1</td>
</tr>
<tr>
<td>Application / Format</td>
<td>Version</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Lotus Ami/Ami Professional</td>
<td>through 3.1</td>
</tr>
<tr>
<td>Lotus WordPro (Intel platforms)</td>
<td>96 through Millennium Edition 9.6</td>
</tr>
<tr>
<td>Microsoft Rich Text Format (RTF)</td>
<td>all versions</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>through 2003</td>
</tr>
<tr>
<td>Microsoft WordPad</td>
<td>all versions</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Microsoft Write</td>
<td>through 3.0</td>
</tr>
<tr>
<td>Novell Perfect Works</td>
<td>2.0</td>
</tr>
<tr>
<td>Professional Write Plus</td>
<td>1.0</td>
</tr>
<tr>
<td>Q&amp;A Write</td>
<td>3.0</td>
</tr>
<tr>
<td>StarOffice / Open Office Writer</td>
<td>5.2, 6.x, 7.x / 1.1 (text only)</td>
</tr>
<tr>
<td>Unicode Text</td>
<td>all versions</td>
</tr>
<tr>
<td>WordStar</td>
<td>1.0</td>
</tr>
<tr>
<td>Word Processing - Macintosh</td>
<td></td>
</tr>
<tr>
<td>MacWrite II</td>
<td>1.1</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>3.0, 4.0, 98, 2001, 2004</td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Novell WordPerfect</td>
<td>1.02 through 3.0</td>
</tr>
<tr>
<td>Word Processing - Unix</td>
<td></td>
</tr>
<tr>
<td>StarOffice Writer</td>
<td>Version 5.2</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>3.0, 4.0, 4.5</td>
</tr>
<tr>
<td>Application / Format</td>
<td>Version</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>First Choice</td>
<td>through 3.0</td>
</tr>
<tr>
<td>Framework</td>
<td>3.0</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (DOS/Windows)</td>
<td>through 5.0</td>
</tr>
<tr>
<td>Lotus 1-2-3 (DOS/Windows)</td>
<td>through 5.0</td>
</tr>
<tr>
<td>Lotus 1-2-3 (OS/2)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Lotus 1-2-3 for SmartSuite</td>
<td>97 through Millennium 9.6</td>
</tr>
<tr>
<td>Lotus Symphony</td>
<td>1.0, 1.1, and 2.0</td>
</tr>
<tr>
<td>Microsoft Excel Charts</td>
<td>2.x through 7.0</td>
</tr>
<tr>
<td>Microsoft Excel (Mac)</td>
<td>3.0 through 4.0, 98, 2001, 2004</td>
</tr>
<tr>
<td>Microsoft Excel (Windows)</td>
<td>2.2 through 2003</td>
</tr>
<tr>
<td>Microsoft Multiplan</td>
<td>4.0</td>
</tr>
<tr>
<td>Microsoft Works (Mac)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Microsoft Works (Windows)</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Microsoft Works (DOS)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Mosaic Twin</td>
<td>2.5</td>
</tr>
<tr>
<td>Novell Perfect Works</td>
<td>2.0</td>
</tr>
<tr>
<td>PFS:Professional Plan</td>
<td>1.0</td>
</tr>
<tr>
<td>Quattro Pro (DOS)</td>
<td>through 5.0</td>
</tr>
<tr>
<td>Quattro Pro (Windows)</td>
<td>through 12.0</td>
</tr>
<tr>
<td>SmartWare II</td>
<td>1.02</td>
</tr>
<tr>
<td>StarOffice / Open Office Writer</td>
<td>5.2, 6.x, 7.x / 1.1 (text only)</td>
</tr>
<tr>
<td>SuperCalc 5</td>
<td>4.0</td>
</tr>
</tbody>
</table>
### File Formats and Translation

<table>
<thead>
<tr>
<th>Application / Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>VP Planner 3D</td>
<td>1.0</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
<tr>
<td>Corel/Novell Presentations</td>
<td>through 12.0</td>
</tr>
<tr>
<td>Harvard Graphics (DOS)</td>
<td>2.x, 3.x</td>
</tr>
<tr>
<td>Harvard Graphics (Windows)</td>
<td>all versions</td>
</tr>
<tr>
<td>Freelance (Windows)</td>
<td>through Millennium 9.6</td>
</tr>
<tr>
<td>Freelance (OS/2)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Microsoft PowerPoint (Windows)</td>
<td>3.0 through 2003</td>
</tr>
<tr>
<td>Microsoft PowerPoint (Mac)</td>
<td>4.0 through 2001, 2004</td>
</tr>
<tr>
<td>StarOffice / Open Office Writer</td>
<td>5.2, 6.x, 7.x / 1.1 (text only)</td>
</tr>
<tr>
<td><strong>Databases</strong></td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td>through 2.0</td>
</tr>
<tr>
<td>dBASE</td>
<td>through 5.0</td>
</tr>
<tr>
<td>DataEase</td>
<td>4.x</td>
</tr>
<tr>
<td>dBXL</td>
<td>1.3</td>
</tr>
<tr>
<td>Enable</td>
<td>3.0, 4.0, 4.5</td>
</tr>
<tr>
<td>First Choice</td>
<td>through 3.0</td>
</tr>
<tr>
<td>FoxBase</td>
<td>2.1</td>
</tr>
<tr>
<td>Framework</td>
<td>3.0</td>
</tr>
<tr>
<td>Microsoft Works (Mac)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Microsoft Works (Windows)</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Microsoft Works (DOS)</td>
<td>through 2.0</td>
</tr>
<tr>
<td>Application / Format</td>
<td>Version</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Paradox (DOS)</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Paradox (Windows)</td>
<td>through 1.0</td>
</tr>
<tr>
<td>Personal R:BASE</td>
<td>1.0</td>
</tr>
<tr>
<td>Q&amp;A</td>
<td>through 2.0</td>
</tr>
<tr>
<td>R:BASE 5000</td>
<td>through 3.1</td>
</tr>
<tr>
<td>R:BASE System V</td>
<td>1.0</td>
</tr>
<tr>
<td>Reflex</td>
<td>2.0</td>
</tr>
<tr>
<td>SmartWare II</td>
<td>1.02</td>
</tr>
<tr>
<td>Other</td>
<td></td>
</tr>
<tr>
<td>Executable (EXE, DLL)</td>
<td>no specific version</td>
</tr>
<tr>
<td>ID3 (MP3, AAC, WMA, Ogg Vorbis, etc.)</td>
<td>text only</td>
</tr>
<tr>
<td>Macromedia Flash (SWF)</td>
<td>text only</td>
</tr>
<tr>
<td>Microsoft Outlook Express (EML)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Outlook Folder (PST)</td>
<td>97, 98, 2002, 2003</td>
</tr>
<tr>
<td>Microsoft Outlook Message (MSG)</td>
<td>all versions</td>
</tr>
<tr>
<td>Microsoft Project 98</td>
<td>98 through 2003 (Datasheet view)</td>
</tr>
<tr>
<td>Microsoft Visio</td>
<td>2003</td>
</tr>
<tr>
<td>Mime Internet mail format</td>
<td></td>
</tr>
<tr>
<td>vCalendar Scheduling</td>
<td>1.0</td>
</tr>
<tr>
<td>vCard Electronic Business Card</td>
<td>Versit 2.1</td>
</tr>
<tr>
<td>WML</td>
<td>specification 5.2</td>
</tr>
<tr>
<td>XML</td>
<td>text only</td>
</tr>
</tbody>
</table>
File Formats and Translation

**GRAPHICS FORMATS**

The following table summarizes the major graphics formats supported by Site Builder. All embedded graphics in the source documents are converted according to the default setting in the Graphics tab dialog of *Formatting*. The options are GIF, JPEG, PNG, and BMP. (The WBMP format is intended for Web pages that will be viewed in an Internet-enabled device.)

You can use any two or three or even all four of the options, assuming that the graphics are associated with different elements. Any linked GIF, JPEG, PNG, or BMP graphics in the source documents are “passed through” by Site Builder during translation. All other linked graphics are governed by the settings in *Formatting*.

<table>
<thead>
<tr>
<th>Application / Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yahoo Instant Message (YIM)</td>
<td>text only</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Photoshop* (PSD)</td>
<td>4.0</td>
</tr>
<tr>
<td>Adobe Illustrator* (AI)</td>
<td>through 7.0, 9.0</td>
</tr>
<tr>
<td>Adobe FrameMaker Graphics (FMV)</td>
<td>vector/raster through 5.0</td>
</tr>
<tr>
<td>Adobe Acrobat* (PDF)</td>
<td>2.1, 3.0 – 7.0</td>
</tr>
<tr>
<td>Ami Draw (SDW)</td>
<td>Ami Draw</td>
</tr>
<tr>
<td>AutoCAD* Interchange and Native Drawing Formats</td>
<td>DXF and DWG</td>
</tr>
<tr>
<td>AutoCAD Drawing</td>
<td>2.5, 2.6, 9.0 through 14.0, 2000i and 2002</td>
</tr>
<tr>
<td>AutoShade Rendering (RND)</td>
<td>2.0</td>
</tr>
<tr>
<td>Binary Group 3 Fax</td>
<td>all versions</td>
</tr>
<tr>
<td>Bitmap (BMP, RLE, ICO, CUR, OS2 DIB, and WARP)</td>
<td>all versions</td>
</tr>
<tr>
<td>Format</td>
<td>Version</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>CALS Raster (GP4)</td>
<td>Type I and Type II</td>
</tr>
<tr>
<td>Corel Clipart format (CMX)</td>
<td>5 through 6</td>
</tr>
<tr>
<td>Corel Draw (CDR)</td>
<td>3.x – 8.x</td>
</tr>
<tr>
<td>Corel Draw* (CDR with TIFF header)</td>
<td>2.x – 9.x</td>
</tr>
<tr>
<td>Computer Graphics Metafile (CGM)</td>
<td>ANSI, CALS, NIST 3.0</td>
</tr>
<tr>
<td>Encapsulated PostScript (EPS)</td>
<td>TIFF header only</td>
</tr>
<tr>
<td>GEM Paint (IMG)</td>
<td>no specific version</td>
</tr>
<tr>
<td>Graphics Environment Manager (GEM)</td>
<td>bitmap and vector</td>
</tr>
<tr>
<td>Graphics Interchange Format (GIF)</td>
<td>all versions</td>
</tr>
<tr>
<td>Hewlett Packard Graphics Language (HPGL)</td>
<td>2.0</td>
</tr>
<tr>
<td>IBM Graphics Data Format (GDF)</td>
<td>1.0</td>
</tr>
<tr>
<td>IBM Picture Interchange Format (PIF)</td>
<td>1.0</td>
</tr>
<tr>
<td>Initial Graphics Exchange Specification* (IGES)</td>
<td>5.1</td>
</tr>
<tr>
<td>JFIF (JPEG not in TIFF format)</td>
<td>all versions</td>
</tr>
<tr>
<td>JPEG (including EXIF)</td>
<td>all versions</td>
</tr>
<tr>
<td>Kodak Flash Pix (FPX)</td>
<td>all versions</td>
</tr>
<tr>
<td>Kodak Photo CD (PCD)</td>
<td>1.0</td>
</tr>
<tr>
<td>Lotus PIC</td>
<td>all versions</td>
</tr>
<tr>
<td>Lotus Snapshot</td>
<td>all versions</td>
</tr>
<tr>
<td>Macintosh PICT1 &amp; PICT2</td>
<td>bitmap only</td>
</tr>
</tbody>
</table>
### File Formats and Translation

<table>
<thead>
<tr>
<th>Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MacPaint (PNTG)</td>
<td>no specific version</td>
</tr>
<tr>
<td>Micrografx Draw (DRW)</td>
<td>through 4.0</td>
</tr>
<tr>
<td>Micrografx Designer (DRW)</td>
<td>through 3.1</td>
</tr>
<tr>
<td>Micrografx Designer* (DSF)</td>
<td>Windows 95, 6.0</td>
</tr>
<tr>
<td>Novell PerfectWorks (Draw)</td>
<td>2.0</td>
</tr>
<tr>
<td>OS/2 PM Metafile (MET)</td>
<td>3.0</td>
</tr>
<tr>
<td>Paint Shop Pro 6 (PSP)</td>
<td>Windows only, 5.0 - 6.0</td>
</tr>
<tr>
<td>PC Paintbrush (PCX and DCX)</td>
<td>all versions</td>
</tr>
<tr>
<td>Portable Bitmap (PBM)</td>
<td>all versions</td>
</tr>
<tr>
<td>Portable Graymap (PGM)</td>
<td>no specific version</td>
</tr>
<tr>
<td>Portable Network Graphics (PNG)</td>
<td>1.0</td>
</tr>
<tr>
<td>Portable Pixmap (PPM)</td>
<td>no specific version</td>
</tr>
<tr>
<td>Postscript* (PS)</td>
<td>Level II</td>
</tr>
<tr>
<td>Progressive JPEG</td>
<td>no specific version</td>
</tr>
<tr>
<td>Sun Raster (SRS)</td>
<td>no specific version</td>
</tr>
<tr>
<td>StarOffice / Open Office Draw</td>
<td>5.2, 6.x, 7.x / 1.1 (text only)</td>
</tr>
<tr>
<td>TIFF</td>
<td>through 6</td>
</tr>
<tr>
<td>TIFF CCITT Group 3 &amp; 4</td>
<td>through 6</td>
</tr>
<tr>
<td>Truevision TGA (TARGA)</td>
<td>2</td>
</tr>
<tr>
<td>Visio (preview)</td>
<td>4</td>
</tr>
<tr>
<td>Visio</td>
<td>5, 2000 and 2002</td>
</tr>
<tr>
<td>WBMP</td>
<td>no specific version</td>
</tr>
</tbody>
</table>
The asterisk (*) denotes a high-end graphics formats. All high-end graphics formats are provided “as is,” without representations or warranties.

**TRANSLATION ISSUES**

**OLE Object Support**

If a source document created in Microsoft Word or Excel (version 97 or 2000) contains an embedded OLE object, Site Builder will, if possible, export a copy of that object. It will create not only an output graphics file as a graphical representation of the object, but also a file for the linked object itself. It will then attempt to link the graphical representation of the OLE object in the output Web page to that file. If that object type is supported by the browser setup, clicking the graphic will display the object in its native format (assuming you have the appropriate application installed on your machine). See also “Preserving links to embedded OLE objects,” in online Help.

Please note that Site Builder cannot export multimedia objects (only the graphical representation of the file will display in the output page). Also, to enable this functionality, you must check **Preserve links to embedded OLE objects where possible** on the Options tab dialog of Globals for the template you associate with your source documents. And in the source document itself, be sure to turn off the options **Float over text** and **Link to file** for the object.

<table>
<thead>
<tr>
<th>Format</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Enhanced Metafile (EMF)</td>
<td>no specific version</td>
</tr>
<tr>
<td>Windows Metafile (WMF)</td>
<td>no specific version</td>
</tr>
<tr>
<td>WordPerfect Graphics (WPG and WPG2)</td>
<td>through 2.0, 7 and 10</td>
</tr>
<tr>
<td>X-Windows Bitmap (XBM)</td>
<td>x10 compatible</td>
</tr>
<tr>
<td>X-Windows Dump (XWD)</td>
<td>x10 compatible</td>
</tr>
<tr>
<td>X-Windows Pixmap (XPM)</td>
<td>x10 compatible</td>
</tr>
</tbody>
</table>
**HTML, XML, and PDF as Input Files**

In addition to creating HTML and XML output files, Site Builder can also accept these formats as input files. And it can incorporate PDF files into a Web publication by creating a page linked to the original file, which can be opened in its native format if the user has Adobe Reader installed. You can also set pass-through conversion options for these file types to add the files to your project in their original format, using their original file names and extensions, and creating a direct link to the file from the publication TOC.

**HTML input files** — When HTML files are added to a project as source documents, the HTML files remain intact, but you can make them consistent with other Web pages in the project by enhancing them with a common background, a title, and navigation buttons.

When you translate files that have linked graphics, such as HTML files, the graphics are copied to the output directory. If you have two HTML source documents that have links to different graphics with the same name, the resulting graphics file names will be incremented to keep them from overwriting each other.

Please note that when Site Builder translates an HTML file, information in the `<HEAD>` of the file, including meta tags, will be passed through unchanged. The element title will be assigned to any titles in the Head. If you want to add an HTML file to your publication in its original format, such as to preserve background and link colors set in the file, you may want to select the pass-through conversion option. See “Passing through source documents without conversion” for more information.

**XML input files** — These will be passed through completely unchanged to the staging or publishing area. Their existence will be noted in the TOC and in the XML Map file. How different browsers (or other viewers) render the file may vary. You can also set a pass-through conversion option for an XML document or Directory Item, explained in “Passing through source documents without conversion.” The XML file is treated the same whether you add it as an input file or set the pass-through conversion option for the file.

**PDF input files** — The original files are passed through to the staging or publishing area. Site Builder creates a page as a placeholder for the PDF file at the appropriate point in the publication. This page is linked to other output pages, according to its order in the translation process. In addition, the page contains a link to the PDF file (Site Builder uses the name of the file as an identifier). When the user clicks the link, the PDF file will open in its native format in Adobe Reader, assuming that application is installed on the user’s machine.

Note: You can also link a PDF file directly from the TOC, instead of from a separate Web page, so the user can open the PDF file from the TOC. See “Passing through source documents without conversion” for more information.
Graphics as Input Files

Graphics files can be selected as input files in Site Builder. When Site Builder converts a graphics file, it will generate a separate HTML file with navigation buttons and a link to the graphic (just as it does for a source document) so the graphic displays on the Web page. Site Builder also handles multi-page graphics. Multi-page images will be displayed in a single HTML file with a title based on the source file name. The title will be represented as a Heading 1 element, which you can use to split a multi-page image into multiple HTML files.

If you want to add a complex graphic to your publication that remains in its original format, you may want to use the pass-through conversion option, described below.

Passing through source documents without conversion

The files you use to create a Web publication may include those in special formats (such as AVI or PDF) that you want Site Builder to preserve. Site Builder can pass through such files and place them in the appropriate output directory so that they are recognized as part of the project. They can then be referenced from within the project and even promoted to a publication’s Table of Contents (TOC).

You can set pass-through conversion options for Directory Items and documents.

When you set pass-through conversion options for a document, that source document is passed through to the output folder in its original format, using the original file name and extension. You can then reference the file in your project. You can also promote the document to the publication TOC, creating a direct link from the TOC to the file. When you set pass-through conversion options for a file, that file does not contain navigational buttons and background colors that may be set for other Web pages in your Web site. This can be useful if you want to link to a PDF file directly from the TOC so the user can open the PDF file from the TOC. (In this case, the user will have to have Acrobat Reader installed on his or her machine. Other files you pass through may require other applications to be available on the user’s machine.)

When you set pass-through options for a Directory Item, the documents matching the criteria you specify are passed through to the output folder during translation in their original format, using their original file names and extensions.

You can set conversion options for one file type, multiple file types, or all documents in that directory. You could use this feature to place all of the files you want to include in your publication without translation into one central location.

Note: Notes
1. To reference a passed-through document in the TOC, promote Title (System), which is the only element available for TOC promotion when using this option.

2. If you do not promote the title of a passed-through document to the TOC, the file is essentially the same as an associated file in Site Builder. See “Associating a file with a publication” in the Help system for more information on associated files.

3. If you choose to treat the files in a Directory Item in a manner similar to associated files, be sure to add the Directory Item to a publication that contains no TOC and no framesets and use a template that contains no promotion to reference pages.

4. You can also include a PDF file in a Web publication as a Web page that contains a link to the original file. See the previous section, “HTML, XML, and PDF as input files,” for more information.

**Disk Space**

If you experience performance difficulties, especially in displaying previews, check to see that you have adequate disk space. Adequate disk space depends upon the number of documents you are trying to translate and their complexity. At the very least, a range of 25-50 free megabytes of disk space is highly recommended for translation purposes — though you may require much more for a large project. This disk space must be on the drive that contains your Temp directory. Of course, you will also require disk space for your translated output.

**Anti-Virus Software**

Conflicts can occur with anti-virus software if you frequently run translations that can result in large log files. With frequent translations, the log file may be more or less continuously updated. Since the log file is frequently changing, it can attract a lot of attention from anti-virus software. As the anti-virus software attempts to review the entire file, more changes could get made to the file. This results in a deadlock situation, where the anti-virus software cannot catch up.

We recommend that you use a unique extension for the log file and set your anti-virus software to ignore files of that extension type. (Choose Application Options from the View menu to set logging options.)
Output HTML Pages

If you delete a source document from a project, the history file will also be updated but the output HTML file from the last translation will not be removed. It is recommended that you delete all files from your output directories before carrying out your final translation.

ABOUT STYLES IN EXCEL AND POWERPOINT

The following may be helpful if you are creating Web pages from spreadsheets created in Microsoft Excel or presentations created in Microsoft PowerPoint.

Please note that Site Builder ships with templates specifically designed for source documents created in Microsoft Excel and Microsoft PowerPoint:

- MS Excel and MS Excel TOC
- MS PowerPoint and MS PowerPoint TOC

Ideally, you should associate these templates with your Excel and PowerPoint source documents, respectively.

Styles in Microsoft Excel

Styles in Microsoft Excel are based on the formatting of the cell. (“Style” here relates to the treatment of numeric values, not to formatting attributes that apply in the case of a Word file, for example.) The Heading 1 style is created by Site Builder; the others are default styles in Excel:

- Heading 1
- Comma
- Comma [0]
- Currency
- Currency [0]
- Normal
- Percent

Heading 1 represents the name of each worksheet. By default, Site Builder creates this style and uses it to split a spreadsheet during translation in order to create a separate HTML file for each worksheet.
Creating a new style in Microsoft Excel

To create a new style in Microsoft Excel, open your spreadsheet and do the following:

1. Select a cell that has the combination of formats you want to include in the new style.
2. From the Format menu, choose **Style** to open that dialog box.
3. In the Style Name text box, type a name for the new style.
4. Click **OK**.

The new style you have created can now be applied to any selected cells in your spreadsheet. It will be saved with the spreadsheet and used to create a new element when the spreadsheet is imported. If the spreadsheet is already part of a project in Site Builder, you can simply open that publication, right-click the spreadsheet in the Contents pane, and choose Import and then Styles.

Styles in Microsoft PowerPoint

When you add a Microsoft PowerPoint presentation to a project, Site Builder imports the styles in the slides that form the presentation.

In general, Site Builder translates content relating to the following:

- Title
- Body text
- Top-level text objects (the content of text boxes that are not inserted in graphics)

The following table summarizes styles available after a PowerPoint presentation has been added to a project, and shows how the styles are mapped in Site Builder.

<table>
<thead>
<tr>
<th>Style</th>
<th>Element</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Heading</td>
<td>Heading 1</td>
<td>Style created by Site Builder where a slide has no title or heading. It is applied to the title and also creates a slide number, based on the slide’s position in the presentation (e.g., “Slide 7”).</td>
</tr>
<tr>
<td>Center Title</td>
<td>Heading 1</td>
<td>A PowerPoint style used for the title of a Title slide.</td>
</tr>
<tr>
<td>Style</td>
<td>Element</td>
<td>Comment</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Heading 1</td>
<td>Heading 1</td>
<td>Style created by Site Builder and applied to the title of a regular slide.</td>
</tr>
<tr>
<td>Slide</td>
<td>Slide</td>
<td>Style created by Site Builder for all slide images (thus allowing them to be turned on or off in the output Web pages).</td>
</tr>
<tr>
<td>Body 1 to 5</td>
<td>Body 1 to 5</td>
<td>All Body styles are mapped to the Body element.</td>
</tr>
<tr>
<td>Center Body 1 to 5</td>
<td>Body 1 to 5</td>
<td>All Body styles are mapped to the Body element.</td>
</tr>
<tr>
<td>Half Body 1 to 5</td>
<td>Body 1 to 5</td>
<td>All Body styles are mapped to the Body element.</td>
</tr>
<tr>
<td>Quarter Body 1 to 5</td>
<td>Body 1 to 5</td>
<td>All Body styles are mapped to the Body element.</td>
</tr>
<tr>
<td>Note 1 to 5</td>
<td>Note 1 to 5</td>
<td>Notes displayed in PowerPoint’s “Speaker Notes” view.</td>
</tr>
<tr>
<td>Text 1 to 5</td>
<td>Text 1 to 5</td>
<td>Text added by the user (only top-level text objects are translated).</td>
</tr>
<tr>
<td>Notes Footer</td>
<td></td>
<td>Ignored by Site Builder</td>
</tr>
<tr>
<td>Notes Header</td>
<td></td>
<td>Ignored by Site Builder</td>
</tr>
<tr>
<td>Slide Footer</td>
<td></td>
<td>Ignored by Site Builder</td>
</tr>
</tbody>
</table>
Appendix

TEMPLATES AND GRAPHICS SETS

Site Builder ships with a set of templates in Default.tcp, the default project file, which are available each time you start a new project:

- there are 28 graphics Sets in Site Builder
- in addition to the standard navigation buttons, all the graphics Sets include Print, Link to Source, Top of Project, and Specific Page links

You can view the graphics Sets in the Gallery, in the Sets mode. The templates are listed in the Manage Templates dialog box (except for the default reference page templates—Default TOC, Default LOF, Default LOT, Default Index, and Default Query—which you select in the Add Reference Page dialog box when you create a new template).

Note: A second default project file, DefaultWML.tcp, is used to create WML projects. (Like Default.tcp, it resides in the ..\Resources\en folder, with a copy available on the CD-ROM.) DefaultWML.tcp has a far more limited selection of templates. For more information, see “Creating a WML Project” in the Documentation folder of your Content Publisher directory.

In summary:

- There are 19 body templates.
- The Blank template contains no styles, ranks, patterns, or metadata, or any of the other default settings noted below. This is the template to use if you simply want to “pass through” a source document to see how it looks without any special formatting (and this is the template that Site Builder uses when you create a new template and do not base it on another template).
- 14 other general-purpose templates have various default settings (promotion, splitting, etc.), as noted in the second table below. These templates also have complementary
TOC, Index, and Query templates. (The same graphics Set is associated with all four templates in each group to ensure a consistent look throughout your publication.)

- The 4 remaining body templates are designed for source documents created in spreadsheet and presentation applications. They have complementary TOC and Query Templates, but no Index.
- Templates with “CSS” in their name have Cascading Style Sheets turned on.

**TEMPLATES AND GRAPHICS SETS IN DEFAULT.TCP**

The table below lists all 19 body templates in the default project file. The graphics Set listed for each body template is also associated with the TOC, Query, and Index templates, where available. (There are 28 graphics Sets in Site Builder, so not all are used.)

<table>
<thead>
<tr>
<th>Template</th>
<th>Graphics Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Academy</td>
<td>Aqua Weave</td>
</tr>
<tr>
<td>Acclaim CSS</td>
<td>Investment</td>
</tr>
<tr>
<td>Account</td>
<td>Clearing House</td>
</tr>
<tr>
<td>Adagio CSS</td>
<td>Gray Tab</td>
</tr>
<tr>
<td>Administration</td>
<td>Planner</td>
</tr>
<tr>
<td>Analysis</td>
<td>Grouted Tiles</td>
</tr>
<tr>
<td>Archive CSS</td>
<td>Scalloped</td>
</tr>
<tr>
<td>Blank</td>
<td></td>
</tr>
<tr>
<td>Business</td>
<td>Blue Bevel</td>
</tr>
<tr>
<td>Ceremonial</td>
<td>Blue Mexico</td>
</tr>
<tr>
<td>Courtesy CSS</td>
<td>Cranberry Script</td>
</tr>
<tr>
<td>Executive</td>
<td>Gray Tab</td>
</tr>
<tr>
<td>Introduction CSS</td>
<td>Blue Peach</td>
</tr>
</tbody>
</table>
DEFAULT SETTINGS FOR 14 GENERAL-PURPOSE TEMPLATES

Following is a list of the default settings for the 14 general-purpose body templates. This isn’t necessarily a complete list of the settings. If you decide to use any of these templates, you should check the template before using it.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics Set</td>
<td>See table above</td>
</tr>
<tr>
<td>Elements promoted to TOC</td>
<td>Title and Heading 1</td>
</tr>
<tr>
<td>Treatment of elements on TOC</td>
<td>Title flush left, Heading 1 indented</td>
</tr>
<tr>
<td>Split</td>
<td>On Heading 1</td>
</tr>
<tr>
<td>Fonts</td>
<td>Take from Source, Arial, or Verdana</td>
</tr>
<tr>
<td>Navigation buttons in Body</td>
<td>Previous Page, Next Page, TOC, and Index (TOC and Index display only if your publication has a TOC and Index)</td>
</tr>
</tbody>
</table>
### DEFAULT SETTINGS FOR 4 SPECIALIZED TEMPLATES

The following table lists the four specialized templates for use when the source documents were created by using one of the spreadsheet or presentation applications shown. See Appendix A, “File Formats and Translation,” for more information on using these applications with Site Builder.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation buttons in TOC</td>
<td>None</td>
</tr>
<tr>
<td>Navigation buttons in Index</td>
<td>None; Index may contain an Element Text Bar</td>
</tr>
<tr>
<td>Navigation buttons in Query</td>
<td>None</td>
</tr>
<tr>
<td>Ranks</td>
<td>Lowest 1, Title, Lowest 2, Heading 1</td>
</tr>
<tr>
<td>Character patterns</td>
<td>HTTP, Weblink, Email</td>
</tr>
<tr>
<td>Metadata</td>
<td>Keywords</td>
</tr>
<tr>
<td>Imported graphics</td>
<td>Converted to Gifs; no alignment</td>
</tr>
<tr>
<td>Continued</td>
<td></td>
</tr>
<tr>
<td>Cascading Style Sheets (CSS)</td>
<td>Turned on for those templates with “CSS” in their name</td>
</tr>
<tr>
<td>Link colors</td>
<td>Specified, but vary with template</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Template</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus 1-2-3</td>
<td>No ranks or metadata.</td>
</tr>
<tr>
<td>Lotus 1-2-3 TOC</td>
<td></td>
</tr>
</tbody>
</table>
### Templates and Graphics Sets

#### Template Guidelines

Here are a few guidelines to consider when managing templates:

- The templates in the default project file are simply a starter list. If you use any of them, it would be best to first review the template settings to confirm what is listed here and to identify any settings that may not be listed.

- If you use any, it would also be best to create a new template based on the template you want to use—giving it a unique name in the process. That way, there will be no danger of ever overwriting the new template.

- When you rename a template, it’s best to do so in the Manage Templates dialog box, which displays the underlying name of each template. This name will be retained in the template even if you rename the template as you export it or rename the template file in Windows Explorer. When you import a template into a project, Site Builder recognizes the underlying template name and compares it to the list of templates already in the project. If there’s a match, you can either overwrite the existing template or rename the one you are importing.

<table>
<thead>
<tr>
<th>Template</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus Freelance</td>
<td>Default styles: Automatic Heading, Heading 1, Normal, Slide, and Speaker Notes.</td>
</tr>
<tr>
<td>Lotus Freelance TOC</td>
<td></td>
</tr>
<tr>
<td>MS Excel</td>
<td>No ranks or metadata.</td>
</tr>
<tr>
<td>MS Excel TOC</td>
<td></td>
</tr>
<tr>
<td>MS PowerPoint</td>
<td>Includes a number of default styles not assigned to elements: Body #1, Body #2, etc.; Center Body 1, Center Body 2, etc. See Appendix A for more information.</td>
</tr>
<tr>
<td>MS PowerPoint TOC</td>
<td></td>
</tr>
</tbody>
</table>
Project files can be quite large. If you want to keep project files small, you might want to delete those templates you are not using. Alternatively, you can edit the project file by exporting most of the templates and “parking” them in a safe place. You can then simply import them as you need them. You might want to do this with the template files you create as well as the ones supplied by Site Builder. Of course, with Site Builder’s linking functionality, you can always link to a “parked” (external) template. However, you will have to import the template into a project to edit it.
THIRD PARTY LICENSES

OVERVIEW

This appendix includes a description of the Third Party Licenses for all the third party products included with this product.

- Apache Software License (page C-1)
- W3C® Software Notice and License (page C-2)
- Zlib License (page C-4)
- General BSD License (page C-5)
- General MIT License (page C-5)
- Unicode License (page C-6)
- Miscellaneous Attributions (page C-7)

APACHE SOFTWARE LICENSE

* Copyright 1999–2004 The Apache Software Foundation.
* Licensed under the Apache License, Version 2.0 (the "License");
* you may not use this file except in compliance with the License.
* You may obtain a copy of the License at
*     http://www.apache.org/licenses/LICENSE-2.0
*
* Unless required by applicable law or agreed to in writing, software
* distributed under the License is distributed on an "AS IS" BASIS,
* WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
* See the License for the specific language governing permissions and
* limitations under the License.

**W3C® SOFTWARE NOTICE AND LICENSE**

* Copyright © 1994-2000 World Wide Web Consortium,
* (Massachusetts Institute of Technology, Institut National de
* Recherche en Informatique et en Automatique, Keio University).
* All Rights Reserved. http://www.w3.org/Consortium/Legal/
* 
* This W3C work (including software, documents, or other related items) is
* being provided by the copyright holders under the following license. By
* obtaining, using and/or copying this work, you (the licensee) agree that
* you have read, understood, and will comply with the following terms and
* conditions:
* 
* Permission to use, copy, modify, and distribute this software and its
* documentation, with or without modification, for any purpose and without
* fee or royalty is hereby granted, provided that you include the following
* on ALL copies of the software and documentation or portions thereof,
* including modifications, that you make:
* 
* 1. The full text of this NOTICE in a location viewable to users of the
   redistributed or derivative work.
* 
* 2. Any pre-existing intellectual property disclaimers, notices, or terms
and conditions. If none exist, a short notice of the following form

(hypertext is preferred, text is permitted) should be used within the
body of any redistributed or derivative code: "Copyright ©

Institute of Technology, Institut National de Recherche en
Informatique et en Automatique, Keio University). All Rights
Reserved. http://www.w3.org/Consortium/Legal/

3. Notice of any changes or modifications to the W3C files, including the
date changes were made. (We recommend you provide URIs to the location
from which the code is derived.)

THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS
MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE
ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR
DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in advertising
or publicity pertaining to the software without specific, written prior
permission. Title to copyright in this software and any associated
documentation will at all times remain with copyright holders.
Zlib License

* zlib.h -- interface of the 'zlib' general purpose compression library
  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
   claim that you wrote the original software. If you use this software
   in a product, an acknowledgment in the product documentation would be
   appreciated but is not required.
2. Altered source versions must be plainly marked as such, and must not be
   misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org
Mark Adler madler@alumni.caltech.edu
GENERAL BSD LICENSE

Copyright (c) 1998, Regents of the University of California
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

"Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE

Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

**UNICODE LICENSE**

**UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE**


NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the Unicode data files and any associated documentation (the "Data Files") or Unicode software and any associated documentation (the "Software") to deal in the Data Files or Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files or Software, and to permit persons to whom the Data Files or Software are furnished to do so, provided that (a) the above copyright notice(s) and this permission notice appear with all copies of the Data Files or Software, (b) both the above copyright notice(s) and this permission notice appear in associated documentation, and (c) there is clear notice in each modified Data File or in the Software as well as in the documentation associated with the Data File(s) or Software that the data or software has been modified.
THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in these Data Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks and registered trademarks mentioned herein are the property of their respective owners

**MISCELLANEOUS ATTRIBUTIONS**

Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.

Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.
Third Party Licenses

Portions Copyright © 1997 Soft Horizons. All rights reserved.
Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.
Red Hat is a registered trademark of Red Hat, Inc.
Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks of Sun Microsystems, Inc.
Sybase is a registered trademark of Sybase, Inc.
UNIX is a registered trademark of The Open Group.
Verity is a registered trademark of Autonomy Corporation plc
A
Add menu, 1-4
anti-virus software when translating, A-14
application options
  default character style, 6-7
  default output extension, 6-7
  logging, 6-6
Application Options dialog box, 6-6
associated file, passing through, A-14
asterisk after a document name, 5-13

B
benefits of staging, 5-14
Blank template, B-1
body page
  defined, 2-8
body page template, B-1

C
Choose a Content Server dialog box, 4-5
commands
  Properties, 4-24, 4-24
  Stage, 5-23
  Translate, 4-24, 4-24
  Translate All, 4-24
  Translate Selected, 4-24
  Update Versions, 5-11
configuring email notifications for a task, 3-9
Confirm Publish Options dialog box, 5-23, 5-23
content author, 2-7
  defined, 5-1
Content Publisher
  supported graphics formats, A-1
  supported text formats, A-1

directory Item
content server
  checking out documents, 4-14
  creating a project file in, 4-3
  opening a project file from, 4-9
  publishing, 5-3
  registering a project on, 5-5
  setup for publishing, 5-3
  source, 5-3
  staging, 5-3
contributor criteria workflow, 5-4
conversion, passing through source documents, A-13
criteria workflow, 5-4

default character style, 6-7
default output extension, 6-7
default output file names, 6-8
Default Paragraph Font, 6-7
default settings in templates, B-3
Default.tcp, 2-7
templates in, B-1
DefaultWML.tcp, 2-7, 2-7
dialog boxes
  Application Options, 1-4, 6-6
  Choose a Content Server, 4-5
  Confirm Publish Options, 5-23, 5-23
  Details, 5-12
  Document Information, 5-19
  Project Check In, 4-4
  Project Check In (New Revision), 4-7
  Project Options, 1-4, 6-1
  Publishing Options, 5-26
  Select a Repository, 4-11
  Specify a Search, 4-17
  Staging Options, 5-17
  Staging/Publishing Options, 5-16
Index

adding a prefix to file names, 6-3

dynamic compared to Folder Import wizard, 4-21
explained, 2-9

restricted type, 5-7

setting an output extension for, 4-19

setting pass-through conversion options for, A-13
disk space required, A-14

document
adding a prefix, 6-3

checking out of Content Server, 4-14

defined, 2-8

passing through without conversion, A-13

setting pass-through conversion options for, A-13

specifying a particular version, 5-12

text formats supported, A-1

updating selectively, 5-11

with asterisk after its name, 5-13

Document Information dialog box, 5-19
dynamic Directory Item
compared to Folder Import wizard, 4-21

E

editing process, 2-4
element
defined, 2-11

explained, 2-4, 2-5
e-mail notifications, configuring for a task, 3-9

extension, setting for check-in to content server, 5-22

F

File menu, 1-3

file system, saving output files to, 4-24

Folder Import wizard
compared to dynamic Directory Item, 4-21

frame
containing frame name, 6-3
frameset
adding to a project, 4-10
frameset layout, explained, 2-10

generating document names from file names, 5-21

graphics as input files, A-13

HTML file as input file, A-12

HTML generation, 6-2

HTML table layout, explained, 2-10

I

input files
graphics as, A-13

HTML, A-12

PDF, A-12

XML, A-12

interface

large toolbar, 1-7

menubar, 1-3

popup menus, 1-7

standard toolbar, 1-6

international versions of Word, translating documents
created in, 6-7

K

key terms, 2-7

L

large toolbar, 1-7

layout
frameset, 2-10

HTML table, 2-10

linked publication
adding to a project, 5-9

explained, 2-7

updating, 5-11

Logfile.txt
attaching to an email notification, 3-13

logging, 6-6

M

Map file, 6-5

master project, 2-7, 5-9

menubar, 1-3

menus
Add, 1-4

File, 1-3

Help, 1-5

Publication, 1-4

Run, 1-5

Server, 1-5

Template, 1-5

View, 1-4
Viewers, 1-5
metadata, explained, 2-12
Microsoft Excel
    creating a new style in, A-16
    styles in, A-15
Microsoft PowerPoint, styles in, A-16
Microsoft Word, default character style, 6-7

N
no script support, 6-3
notification levels for email on a task, 3-12

O
OLE objects
    support for, A-11
options, staging, 5-14
output
    publishing, 5-10
    staging, 5-10
Output Character Set, 6-2
output file names, 6-8
output files, saving to the file system, 4-24
output name prefix, 6-3

P
passing through documents without conversion, A-13
pattern
    defined, 2-12
    explained, 2-4
PDF file as input file, A-12
popup menus, 1-7
prefix, adding to output file names, 6-3
preview, registering a project for, 5-4, 5-5
print publication script, 6-5
problem report
    defined, 2-10
project
    defined, 2-7
    master, 2-7, 5-9
    publishing, 5-27
    registering, 2-10
    registering for previews, 5-4
    registering on a source server, 5-5
    staging, 5-14, 5-23
project author, 2-7
    defined, 5-1
Project Check In (New Revision) dialog box, 4-7
Project Check In dialog box, 4-4
project file, 2-6
companion history file, 4-5
default, 2-6
default WML, 2-7
Default.tcp, 2-7
defined, 2-7
opening from Content Server, 4-9
saving to Content Server, 4-3
versioning, 3-4
versioning in Site Builder, 4-6
versioning in Site Server, 4-7
project options
    containing frame name, 6-3
    file names, 6-3
    HTML generation, 6-2
    output character set, 6-2
    output name prefix, 6-3
    print publication script, 6-5
    when using Site Server, 6-9
XML Map file, 6-5
Project Options dialog box, 6-1
Project Registrations dialog box, 5-6
Properties command, 4-24
property values
    inheriting, 5-19
    overriding for staged output, 5-24
publication
    defined, 2-8
    explained, 2-8
    linked, 2-7, 5-9
    updating linked, 5-11
Publication menu, 1-4
Publication Properties dialog box, 4-25
published output, adding a prefix to file names, 6-3
publishing
    defined, 2-10
    publishing a project, 5-27
Publishing Options dialog box, 5-26
publishing output, 5-10
publishing with errors, 6-3

R
rank
    defined, 2-12
    explained, 2-4
reference page
    defined, 2-9
reference page template, B-1
registration
    on a source server, 5-4, 5-5
    on a staging server, 5-4, 5-20
registration, 2-10, 5-4
Release date for staging, 5-13
Index

repository, explained, 2-9
restricted Directory Item, creating, 5-7
Run menu, 1-5

S
security settings
  inheriting, 5-19
  overriding for staged output, 5-24
Select a Repository dialog box, 4-11
server errors, generating an email notification, 3-9
Server menu, 1-5
Seven Easy Lessons, access from Startup Screen, 1-2
Site Builder
  Add a Document wizard, 1-2
  associating a Web browser, 6-10
  versioning a project file in, 4-6
Site Server
  configuring to send email notifications, 3-9
  project options when using, 6-9
  versioning a project file in, 4-7
  versioning the project file, 3-4
source document
  defined, 2-8
  passing through without conversion, A-13
source server, registering a project on, 5-5
Stage command, 5-23
staged output
  adding a prefix to file names, 6-3
  overriding property values, 5-24
  overriding security settings, 5-24
  using current date for, 5-13
staging
  a project, 5-14, 5-23
  benefits of, 5-14
  criteria workflow, 5-4
  defined, 2-9
  output, 5-10
  server for, 5-16
  setting options, 5-14
Staging Options dialog box, 5-17
staging server
  registering a project on, 5-20
staging workflow, 2-10
Staging/Publishing Options dialog box, 5-16
standard toolbar, 1-6
style
  defined, 2-11
  explained, 2-4
  in Microsoft Excel, A-15
  in Microsoft PowerPoint, A-16
subpublication, updating for latest version, 5-11
superuser, Webmaster set up as, 3-15

support for OLE Objects, A-11
supported graphics formats, A-1

T
table layout explained, 2-10
tables
  HTML, 2-10
task
  configuring email notifications, 3-9
  suspending, 3-19
task list
  explained, 3-16
  managing, 3-15
template
  Blank, B-1
  body page, B-1
  CSS, B-2
default settings, B-3
defined, 2-11
editing process, 2-4
explained, 2-5
general purpose, B-1
guidelines, B-5
in Default.tcp, B-1
presentation, B-2, B-4
reference page, B-1
spreadsheet, B-2, B-4
Template menu, 1-5
toolbars
  large, 1-7
  standard, 1-6
Translate All command, 4-24, 4-24
Translate command, 4-24
Translate Selected command, 4-24
translation, 5-12, A-13, A-13
  passing through documents without conversion, A-13
  using non-English versions of Word, 6-7
  what happens during, 2-5
translation issues
  deleting output HTML files, A-15
  running anti-virus software, A-14
Tutorial, access from Startup Screen, 1-2

U
UNC path, importance of using, 3-7
Unicode, 6-2
Update Versions command, 5-11
selecting documents to update, 5-11
updating a linked publication, 5-11
V
versioning the project file, 3-4
View menu, 1-4
Viewers menu, 1-5
viewers, setting up, 6-10

W
Web browser, associating with Site Builder, 6-10
Web page
defined, 2-8
Web publication, defined, 2-8
Web site, defined, 2-10
Webmaster, 2-8
defined, 5-1
wizards
Add a Document, 1-2
Word, translation source documents created in
international versions, 6-7
workflow
contributor criteria, 5-4
different types, 5-4
staging criteria, 2-10, 5-4

X
XML file as input file, A-12
XML Map file, 6-5